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1 Preface

1.1 Documentation Overview

The user documentation for the R&S SMW consists of the following parts:

● Getting Started printed manual
● Online Help system on the instrument
● Documentation CD-ROM with:

– Getting Started
– Online help system (*.chm) as a standalone help

– User Manuals for base unit and options
– Service manual
– Data sheet and product brochure
– Links to useful sites on the R&S internet

Online Help

The Online Help is embedded in the software. It offers quick, context-sensitive access to
the complete information needed for operation and programming. The online help con-
tains help on operating the R&S SMW and all available options.

Getting Started

This manual is delivered with the instrument in printed form and in PDF format on the
documentation CD. It provides the information needed to set up and start working with
the instrument. Basic operations and typical measurement examples are described.
Safety information is also included.

User Manual

User manuals are provided for the base unit and each additional (software) option.

The user manual for the base unit is a supplement to the Getting Started manual and
provides basic information on operating the R&S SMW in general. In this manual, all
instrument functions are described in detail. Furthermore, it provides a complete descrip-
tion of the remote control commands with programming examples. An introduction to
remote control is provided, as well as information on maintenance, instrument interfaces
and troubleshooting.

In the user manuals for the individual software options, the specific instrument functions
of this option are described in detail. For additional information on default settings and
parameters, refer to the data sheets. Basic information on operating the R&S SMW is not
included in these user manuals.

The user manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument.

 

 

Documentation Overview
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All user manuals are also available for download from the R&S website, on the R&S SMW
product page at http://www.rohde-schwarz.com/product/SMW.html.

Service Manual

This manual is available in PDF format on the CD delivered with the instrument. It
describes how to check compliance with rated specifications, instrument function, repair,
troubleshooting and fault elimination. It contains all information required for repairing the
R&S SMW by replacing modules.

Release Notes

The release notes describe the installation of the firmware, new and modified functions,
eliminated problems, and last minute changes to the documentation. The corresponding
firmware version is indicated on the title page of the release notes. The most recent
release notes are available for download from the R&S website, on the R&S SMW product
page at http://www.rohde-schwarz.com/product/SMW.html > Downloads > Firmware.

Web Helps

Web helps are provided for the base unit and each additional (software) option. The
content of the web helps correspond to the user manuals for the latest product versions.

The web help is an additional file format that offers quick online access. The web helps
are not intended for download but rather to access the required information directly form
the R&S website.

Web helps are available at the R&S website, on the R&S SMW product page at http://
www.rohde-schwarz.com/product/SMW.html > Download > Web Help.

1.2 Conventions Used in the Documentation

1.2.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as dia-
log boxes, menus, options, buttons, and softkeys are enclosed by quota-
tion marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

 

 

Conventions Used in the Documentation
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Convention Description

​Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quotation
marks.

1.2.2 Conventions for Procedure Descriptions

When describing how to operate the instrument, several alternative methods may be
available to perform the same task. In this case, the procedure using the touchscreen is
described. Any elements that can be activated by touching can also be clicked using an
additionally connected mouse. The alternative procedure using the keys on the instru-
ment or the on-screen keyboard is only described if it deviates from the standard oper-
ating procedures.

The term "select" may refer to any of the described methods, i.e. using a finger on the
touchscreen, a mouse pointer in the display, or a key on the instrument or on a keyboard.

 

Conventions Used in the Documentation
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2 Introduction
The R&S Signal Generator equipped with option R&S SMW-K40 enables you to generate
signals in accordance with the GSM/EDGE standard, based on the GMSK and 8PSK
modulation. Option R&S SMW-K41 EDGE Evolution extends the GSM/EDGE signal
generation with simulation of higher order modulations (QPSK, 16QAM and 32QAM) for
higher symbol rate bursts and higher order modulations (16QAM and 32QAM) for normal
symbol rate bursts.

GSM is a TDMA standard for cellular mobile radio networks and is used worldwide. The
R&S Signal Generator is suitable as a signal generator for all GSM variants. There is no
restriction regarding the use of GSM slots, EDGE slots and EDGE Evolution slots.

The R&S Signal Generator can generate both the transmitter signal of a base station (BS)
and the transmitter signal of user equipment (UE).

Every TDMA frame consists of 8 timeslots (or simply "slots"). Each slot can be separately
turned on or off. A maximum of 7 different level attenuation values can be defined and
allocated separately to the 8 slots quite independently of one another.

In order to configure a slot it is necessary to define a burst type. Different burst types are
available, depending on the installed options on the instrument.

For instruments equipped only with optionR&S SMW-K40, you can choose between data
bursts Normal (full rate and half rate) and EDGE; control bursts Access, Frequency Cor-
rection and Synchronization; a Dummy Burst; and bursts for test purposes, All_Data
(GSM and EDGE). Not only can you generate half rate slots but you can also define
multislots for HSCSD (high speed circuit switched data) and (E)GPRS (general packet
radio service) configurations at the physical level, if necessary allocating multiple slots to
a single connection (channel banding).

The optionR&S SMW-K41 extends the available burst types with burst types defined for
normal symbol rate and higher order modulation schemes such as the data burst Normal
(16QAM and 32QAM) and All_Data (16QAM and 32QAM) as well as with the burst types
defined for higher symbol rates HSR (QPSK, 16QAM and 32QAM) and HSR All_Data
(QPSK, 16QAM and 32QAM).

Higher symbol rates are achieved by reduction of the symbol period and employing of
higher symbol rate bursts (HB) instead of the normal burst (NB). A normal burst contains
116 encrypted symbols and uses time slots with normal duration (156 or 157 symbols
long). The higher symbol rate bursts carry information on full rate packet traffic channels,
contain 138 encrypted symbols and use time slots with reduced symbol duration (187 or
188 symbols long).

The option R&S SMW-K41 provides additionally the functionality to configure and gen-
erate burst for VAMOS operation. All_Data (AQPSK) and Normal (AQPSK) bursts for full
and half rate operation are available.

The modulation data is continuously inserted into the chosen slots (in realtime). In this
fashion the data generator uses a digital signal processor to generate a data stream
complete with modulation data and control signals for power ramping.

This data stream is converted into I/Q signals in the modulation encoder.
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The signal is processed depending on the configured modulation scheme and selected
symbol rate mode:
● In accordance with the GSM standard, the MSK modulation type is set by default to

a symbol rate of 270.833 ksymb/s and Gauss filtering. The symbol rate can be
changed in the instrument. FSK with adjustable span can also be used as the mod-
ulation type.

● In accordance with the standard, in the case of EDGE slots the 8PSK modulation
type is set by default to 3/8( rotation at a symbol rate of 270.833 ksymb/s and Gauss
linearized filtering.

● In accordance to EDGE Evolution specifications (option R&S SMW-K41), the EDGE
Evolution slots in a normal burst (NB) are 16QAM or 32QAM modulated at a symbol
rate of 270.833 ksymb/s and Gauss linearized filtering. The EDGE Evolution slots in
a higher symbol rate bursts (HB) are QPSK, 16QAM or 32QAM modulated at a sym-
bol rate of 325 ksymb/s and spectrally Narrow or Wide Pulse Shape filtering.

● In accordance to VAMOS specifications (option R&S SMW-K41), the slots are
AQPSK modulated at a symbol rate of 270.833 ksymb/s and Gauss linearized filter-
ing.

Three modes for each the normal and the higher symbol rate mode are available for
configuring a GSM/EDGE signal:
● Mode Unframed - a signal with standard-compliant modulation parameters but with-

out slot and frame structure is generated.
● Mode Frame (Single) - a signal consisting of a frame is generated; it is also possible

to choose half rate bursts and to define multislots.
● Mode Frame (Double) - a signal consisting of two frames is generated; the frames

are repeated according to a defined default.

2.1 VAMOS (Voice services over Adaptive Multi-user chan-
nels on One Slot)

According to 3GPP TS 45.001, with VAMOS it is possible to serve two MS simultaneously
on the same physical resource. Thus the voice channel capacity in the CS domain can
be doubled.

Each of the two VAMOS users is assigned a so-called VAMOS subchannel, i.e. the
physical radio resource is split into two subchannels, one for each VAMOS user. The two
subchannels are separated in uplink and downlink via training sequences. For this pur-
pose 3GPP TS 45.002 defines two sets of Training Sequence Codes (TSC). One VAMOS
user/subchannel gets a training sequence from TSC set 1, the other from TSC set 2. This
ensures that the two training sequences have a very low cross-correlation. All mobiles
must support TSC set 1, but only mobiles explicitly indicating support for VAMOS must
also support TSC set 2.

In the uplink two GMSK modulated signals interfere with each other and the base station
receiver requires an advanced multi-user detection algoritm.

 

VAMOS (Voice services over Adaptive Multi-user channels on One Slot)
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In the downlink a novel modulation scheme is used for each subchannel. The two sub-
channels are combined orthogonally by mapping them to the I and Q axis. This results
in a QPSK modulation scheme, where each constellation point has a subchannel 1 com-
ponent and a subchannel 2 component, as shown in the following figure.

Fig. 2-1: QPSK modulation, sum of both subchannels

In this figure both subchannels use the same power level. VAMOS allows subchannel-
specific power control, so that the two subchannels can use different power levels, e.g.
when the two users are located at different distances from the base station. The resulting
modulation scheme is called Adaptive QPSK (AQPSK). The following figure shows an
example where subchannel 2 mapped to the Q-axis uses a higher power level than sub-
channel 1 mapped to the I-axis.

VAMOS (Voice services over Adaptive Multi-user channels on One Slot)
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Fig. 2-2: AQPSK modulation, subchannel 2 with higher power level

The power level of subchannel 2 relative to the power level of subchannel 1 is called
Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle α as follows:

SCPIR = 20 * log10(tan α) dB,

where the value of α shall be chosen such that |SCPIR|≤10dB

For α = 45° the SCPIR equals 0 dB and the two power levels are equal.

AQPSK modulation is applied in the downlink if speech frames have to be transmitted on
both subchannels simultaneously.

The R&S Signal Generator allows to set the SCPIR and configure the VAMOS subchan-
nels, TSC set and TSC used. The available VAMOS settings depend on the mode the
signal is generated in:
● "Unframed"

Two data sources are provided, one per each VAMOS subchannel; the data is
AQPSK modulated but only one SCPIR can be configured.

● "Framed (Single)"
Full Rate, Half Rate and combination of both slot types are supported. The charac-
teristics of each of the half rate slots can be adjusted individually
Separate data source is provided per each VAMOS subchannel and each user in half
rate mode; the data is AQPSK modulated and eigth SCPIRs can be configured
Training Sequence (TSC) set and TSC used can be configured on a VAMOS sub-
channel/User basis

● "Framed (Double)"
The settings of each of the two frames are as in the "Framed (Single)" mode.

VAMOS (Voice services over Adaptive Multi-user channels on One Slot)
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3 GSM/EDGE User Interface
► To access the GSM/EDGE settings, select "Baseband > GSM/EDGE".

The remote commands required to define these settings are described in ​chapter 4,
"Remote-Control Commands", on page 61.

3.1 General Settings

This tab provides access to the default and the "Save/Recall" settings. The choice of
sequence mode determines which parameters are available.

► To access this dialog for setting the GSM/EDGE digital standard, select "Baseband
> GSM/EDGE > General".

This tab comprises the standard general settings.

State
Enables/disables the GSM/EDGE standard.

Enabling this standard disables all the other digital standards and digital modulation
modes in the same baseband.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​STATe ​ on page 68

Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

 

 

General Settings
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Parameter Value

State Not affected by Set to Default

Mode Framed (single)

Modulation  

Symbol Rate Mode Normal Symbol Rate

Symbol Rate 270.833 ksymb/s

Ignore 1/4... Off

Force Dummy Bits to 1 Off

Mod. Type GSM MSK 1bit/sym

Filter Gauss

Filter Par. BT 0.3

Power Ramp Control  

Ramp Time 2 sym

Function Cosine

Slot Attenuation 1...7 0 dB

Slot 0 Configuration  

Burst Type Normal (full rate)

Slot Level Full

Multislot Off

Number of Slots 1

Data PRBS 9

Use Stealing Flag On

Stealing Flag 0

TSC Set 1, TSC 0

Slot 1-7 Configuration  

Slot Level,

other settings as slot 0

Off

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRESet ​ on page 64

Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibili-
ties in the dialog are self-explanatory.

The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

General Settings
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See also, chapter "File and Data Management" in the R&S SMW User Manual.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​CATalog? ​ on page 65
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​LOAD ​ on page 66
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​STORe ​ on page 66
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​DELete ​ on page 65

Generate Waveform File…
With enabled signal generation, triggers the instrument to store the current settings as
an ARB signal in a waveform file. Waveform files can be further processed by the ARB
and/or as a multi carrier or a multi segment signal.

The file name and the directory it is stored in are user-definable; the predefined file
extension for waveform files is *.wv.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​WAVeform: ​CREate ​ on page 68

Sequence Mode
Selects GSM/EDGE mode.

There are three modes available:
● Unframed

see ​chapter 3.6, "Mode Unframed", on page 24
● Framed (single)

see ​chapter 3.7, "Mode Framed (single)", on page 26
● Framed (double)

see ​chapter 3.8, "Mode Framed (double)", on page 27

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​MODE ​ on page 64

Symbol Rate Mode
(for instruments equipped with option R&S SMW-K41 only)

Set the symbol rate mode, i.e. determines whether a normal bursts (NB) or higher symbol
rate bursts (HB) will be generated.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SRATe: ​MODE ​ on page 67

Simulation Mode
Selects the modulation for the signal for the "Unframed" "Sequence Mode"

The signal is generated without slot or frame structure.

The available simulation modes depend on the selected symbol rate:
● Normal Symbol Rate - GSM (MSK or FSK), AQPSK, 8PSK/EDGE, 16QAM and

32QAM
● Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.

General Settings
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For GSM, the modulation to be used (MSK or FSK) is set by means of the parameter
"Modulation" in the "Modulation/Filter" menu.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SMODe ​ on page 66

Modulation/Filter
Access the "Modulation/Filter" dialog, see ​chapter 3.10, "Modulation/Filter",
on page 31.

Remote command: 
n.a.

Power Ramping/Slot Attenuations
Access the "Power Ramping/Slot Attenuation" dialog. This dialog is used to set the power
ramping parameters and for setting values for the level attenuation in dB, see ​chap-
ter 3.11, "Power Ramping/Slot Attenuation", on page 40.

The currently selected ramp function and ramp time are displayed.

Remote command: 
n.a.

3.2 Trigger Settings

This tab provides access to the settings necessary to select and configure the trigger,
like trigger source, mode, trigger delay, trigger suppression, as well as to arm or trigger
an internal trigger manually. The current signal generation status is displayed in the
header of the tab together with information on the enabled trigger mode. As in the
"Marker" and "Clock" tabs, this tab provides also an access to the settings of the related
connectors.

This section focuses on the available settings.
For information on how these settings affect the signal, refer to chapter "Basics" in the
R&S SMW user manual.

► To access this dialog, select "Baseband > GSM/EDGE > Trigger In".

 

Trigger Settings



GSM/EDGE User InterfaceGSM/EDGE, EDGE Evolution

16User Manual 1175.6684.02 ─ 02

This dialog comprises the settings required for configuring the trigger signal.

Routing and Enabling a Trigger
The provided trigger signals are not dedicated to a particular connector but can be map-
ped to one or more globally shared USER or local T/M/(C) connectors.
Use the ​Local and Global Connector Settings to configure the signal mapping as well as
the polarity, the trigger threshold and the input impedance of the input connectors.
To route and enable a trigger signal, perform the following general steps:
● Define the signal source and the effect of a trigger event, i.e. select the "Trigger In >

Mode" and "Trigger In > Source"
● Define the connector, USER or T/M/(C), the selected signal is provided at, i.e. con-

figure the ​Local and Global Connector Settings.

Trigger Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal generation.

Note: To enable simultaneous signal generation in all basebands, the trigger settings in
the available basebands are coupled in any instrument's configuration involving signal
routing with signal addition (e.g. MIMO configuration, routing and summing of basebands
and/or streams).

For more information, refer to chapter "Basics" in the R&S SMW user manual.

● "Auto"
The signal is generated continuously.

● "Retrigger"
The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed_Auto"
The signal is generated only when a trigger event occurs. Then the signal is generated
continuously.

Trigger Settings
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An "Arm" stops the signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Armed_Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is generated
continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal with or exter-
nal) causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is generated
once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​TRIGger]: ​SEQuence ​ on page 82

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​SLUNit ​ on page 86

Trigger Signal Duration
Enters the length of the signal sequence to be output in the "Single" trigger mode. The
input is expressed in the signal units.

Use this parameter to deliberately output part of the signal, an exact sequence of the
signal, or a defined number of repetitions of the signal.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​SLENgth ​ on page 86

Running/Stopped
For enabled modulation, displays the status of signal generation for all trigger modes.

● "Running"
The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​RMODe? ​ on page 85

Arm
Stops the signal generation until subsequent trigger event occurs.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​ARM: ​EXECute ​ on page 83

Execute Trigger
For internal trigger source, executes trigger manually.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​EXECute ​ on page 84

Trigger Settings
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Trigger Source
Note: To enable simultaneous signal generation in all basebands, the trigger settings in
the available basebands are coupled in any instrument's configuration involving signal
routing with signal addition (e.g. MIMO configuration, routing and summing of basebands
and/or streams).

For more information, refer to chapter "Basics" in the R&S SMW user manual.

The following sources of the trigger signal are available:
● "Internal"

The trigger event is executed manually by the "Execute Trigger".
● "Internal (Baseband A/B)"

The trigger event is provided by the trigger signal from the other basebands.
● "External Global Trigger 1 / 2"

The trigger event is the active edge of an external trigger signal provided and con-
figured at the global USER connectors.

● "External Global Clock 1 / 2"
The trigger event is the active edge of an external global clock signal provided and
configured at the global USER connectors.

● "External Local Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the local T/M/(C) connector.
With coupled trigger settings, the signal has to be provided at the T/M/C 1/2/3 con-
nectors.

● "External Local Clock"
The trigger event is the active edge of an external local clock signal provided and
configured at the local T/M/C connector.
With coupled trigger settings, the signal has to be provided at the T/M/C 1 connector.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​SOURce ​ on page 87

Sync. Output to External Trigger
For an external trigger signal, enables/disables the output of a signal synchronous to the
external trigger event.

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first samples
are cut off and no signal is output. After elapsing of the internal pro-
cessing time, the output signal is synchronous to the trigger event.

Trigger Settings
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"Off" The signal output begins after elapsing of the processing time and starts
with sample 0, i.e. the complete signal is output.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the instru-
ment.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​EXTernal: ​SYNChronize: ​OUTPut ​
on page 84

External Trigger Delay
For external trigger signal or trigger signal from the other path, sets the trigger signal
delay.

One possible application field of this feature is the synchronization of the instrument with
the device under test (DUT) or other external devices.

For more information, see chapter "Basics" in the R&S SMW User Manual.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger[: ​EXTernal]: ​DELay ​ on page 88
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OBASeband: ​DELay ​ on page 85

External Trigger Inhibit
For external trigger signal or trigger signal from the other path, sets the duration a new
trigger event subsequent to triggering is suppressed. In "Retrigger" mode for example, a
new trigger event will not cause a restart of the signal generation until the specified inhibit
duration does not expire.

For more information, see chapter "Basics" in the R&S SMW User Manual.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger[: ​EXTernal]: ​INHibit ​ on page 88
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OBASeband: ​INHibit ​ on page 85

3.3 Marker Settings

This tab provides an access to the settings necessary to select and configure the marker
output signal, like the marker mode or marker delay settings.
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This section focuses on the available settings.
For information on how these settings affect the signal, refer to chapter "Basics" in the
R&S SMW user manual.

► To access this dialog, select "Baseband > GSM/EDGE > Marker".

This dialog comprises the settings required for configuring the marker.

Routing and Enabling a Marker
The provided marker signals are not dedicated to a particular connector but can be map-
ped to one or more globally shared USER or local T/M/(C) connectors.
To route and enable a marker signal, perform the following general steps:
● Define the shape of the generated marker, i.e. select the "Marker > Mode"
● Define the connector, USER or T/M/(C), the selected signal is output at, i.e. configure

the ​Local and Global Connector Settings.

Marker Mode
Marker configuration for up to three marker channels. The settings are used to select the
marker mode defining the shape and periodicity of the markers. The contents of the dialog
change with the selected marker mode.

Marker Settings
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"As defined in
Slots"

The marker defined for each slot separately in the burst editor is used.
The name of the marker is displayed to the right of the selection. Defi-
nition of the slot marker is described in ​chapter 3.13, "Slot Marker Def-
inition", on page 56.

"Slot" A slot clock with the slot period specified under Period is generated on
the output connector. The marker signal is generated after every speci-
fied number of slots.
It is important to be aware of the variation in the GSM/EDGE slot length
between 156 and 157 symbols. At a slot length of 156 symbols, a period
of 1 symbol and a symbol rate of 270.833 ksymb/s the clock is
0.577 ms, and at 157 symbols it is 0.580 ms

"Restart" A marker signal is generated at the start of each ARB sequence.

"Frame " A frame clock with the frame period specified under "Period" is gener-
ated on the output connector. The marker signal is generated after
every specified number of frames.
A GSM/EDGE frame has 1250 symbols. At a symbol rate of 270.833
ksymb/s and a period of 1 the clock is 4.615 ms.

"Pulse" A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse" is
selected, and the resulting pulse frequency is displayed below it.
The maximum pulse frequency is half the symbol rate.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​PULSe: ​DIVider ​ on page 94
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​PULSe[: ​FREQuency]? ​
on page 94

"Pattern" A marker signal that is defined by a bit pattern is generated. The pattern
has a maximum length of 64 bits and is defined in an input field which
opens when pattern is selected.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​PATTern ​ on page 93

Marker Settings
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"ON/OFF
Period"

A regular marker signal that is defined by an ON/OFF ratio is generated.
A period lasts one ON and OFF cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples and are set in an input field which opens when ON/OFF ratio
is selected.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​ONTime ​ on page 92
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​OFFTime ​ on page 92

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​MODE ​ on page 91

Marker x Delay
Defines the delay between the marker signal at the marker outputs relative to the signal
generation start.

"Marker x" For the corresponding marker, sets the delay as a number of symbols.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​DELay ​ on page 90

"Current Range without Recalculation"
Displays the dynamic range within which the delay of the marker signals
can be set without restarting the marker and the signal.
Move the setting mark to define the delay.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​DELay: ​MINimum? ​ on page 91
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​DELay: ​MAXimum? ​ on page 90

"Fix marker delay to current range"
Restricts the marker delay setting range to the dynamic range.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut: ​DELay: ​FIXed ​ on page 90

3.4 Clock Settings

This tab provides an access to the settings necessary to select and configure the clock
signal, like the clock source and clock mode.

This section focuses on the available settings.
For information on how these settings affect the signal, refer to chapter "Basics" in the
R&S SMW user manual.
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► To access this dialog, select "Baseband > GSM/EDGE > Clock".

This dialog comprises the settings required for configuring the clock.

Defining the Clock
The provided clock signals are not dedicated to a particular connector but can be mapped
to one or more globally shared USER and the two local T/M/C connectors.
Use the ​Local and Global Connector Settings to configure the signal mapping as well as
the polarity, the trigger threshold and the input impedance of the input connectors.
To route and enable a trigger signal, perform the following general steps:
● Define the signal source, i.e. select the "Clock > Source"
● Define the connector, USER or T/M/C, the selected signal is provided at, i.e. configure

the ​Local and Global Connector Settings.

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
● "External Global Clock 1/2"

The instrument expects an external clock reference at the global USER connector,
as configured in the "Global Connector Settings" dialog.

● "External Local Clock"
The instrument expects an external clock reference at the local T/M/C connector.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​SOURce ​ on page 82

Clock Settings
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Clock Mode
Enters the type of externally supplied clock.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​MODE ​ on page 80

Symbol Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​MULTiplier ​ on page 81

Symbol Clock Divider
Enters the divider for clock type "Fraction".

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​DIVider ​ on page 81

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command: 
CLOCk:INPut:FREQuency?

3.5 Local and Global Connector Settings

Each of the "Trigger In", "Marker" and "Clock" dialogs as well as the "Trigger Marker
Clock" dialog provides a quick access to the related local and global connector settings.

For more information, refer to the description R&S SMW User Manual, section "Local and
Global Connectors".

3.6 Mode Unframed

1. To access this dialog select "General > Sequence Mode > Unframed".

2. Select "Unframed Configuration".

 

 

Local and Global Connector Settings
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This dialog displays the signal in Unframed mode - no frames, no power ramping.

In "Unframed" mode a modulation signal without slot or frame structure is generated. The
modulated carrier without power ramping is often enough for initial tests, and in case the
complete signal is not yet needed.

Since all the modulation parameters for the signal are conform to the standard, only the
symbol rate mode (normal or higher symbol rate) and the modulation (MSK or FSK for
GSM, 8PSK EDGE for EDGE and 16QAM EDGE or 32QAM EDGE for EDGE Evolution)
have to be selected. The symbol rate and filter configuration are set accordingly.

This mode can be used for quick measurements of the spectrum or signal quality (e.g.
EVM).

Provided are the following settings:

Data
Selects data source.

You may choose from the following data sources:

"All 0, All 1" 0 data or 1 data is internally generated.

"Pattern" A user-definable bit pattern with a maximum length of 32 bits is inter-
nally generated.
The bit pattern is defined in the "Pattern" input box.

"PRBS xx" PRBS data in accordance with the IUT-T with period lengths between
29-1 and 223-1 are internally generated.

"Data List" Internal data from a programmable data list created with the aid of the
data editor is used.
Data lists are selected from the Select List subdialog.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA ​ on page 101
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​PATTern ​ on page 103
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt ​ on page 102

Mode Unframed
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3.7 Mode Framed (single)

1. To access this dialog select "General > Sequence Mode > Framed (Single)".

2. Select "Framed (Single) Configuration".

This dialog displays the frame structure and gives access to the dialog for saving and
loading a frame structure.

The "Framed (single)" mode generates a modulation signal which is defined by the struc-
ture of a single frame. The frame structure is repeated cyclically, but the useful data is
continuously generated.

The frame structure is displayed in graphical form. Slot parameters can be defined in the
burst editor, which is called when the slot is selected in the graphical display (see ​chap-
ter 3.12, "Burst Editor", on page 43). You can define half rate slots. The characteristics
of each half rate slot can be defined separately. Each active slot is represented by a burst
symbol. Two half rate slots occupy the space of a full rate slot. A slot in which the level
has been attenuated is represented by a lower amplitude burst. Inactive slots (Slot Level
= Off) are shown as a horizontal bar. If multislots have been defined, the banded slots
are surrounded by a frame (slots 5 to 7 in the illustration).

When a half rate slot has been selected, two frames are generated alternately. Each
frame holds one of the two half rate users.

 

Mode Framed (single)
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Example: 
The following configuration is set, from a frame with two slots that contain half rate users:

As a result, the following two frames are generated alternately:
● Frame with half rate user 1:

● Frame with half rate user 2

Provided are also the following settings:

Save/Recall Frame …
Access the "Save/Recall Frame" dialog for selecting of predefined or user defined frames,
see ​chapter 3.9, "Save Recall Frame/Slots", on page 29.

Remote command: 
n.a.

3.8 Mode Framed (double)

1. To access this dialog select "General > Sequence Mode > Framed (Double)".

2. Select "Framed (Double) Configuration".

 

Mode Framed (double)
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This dialog displays the frame structure and gives access to the dialog for saving and
loading a frame structure.

The "Framed (double)" mode generates multiframe signals which are defined by the
structure of two frames.

For this purpose two frames are defined as in "Framed (single)" mode. A repetition factor
is then specified for each of the two frames. Following a trigger the first frame is repeated
the specified number of times, and then the second frame. The frame structures are
repeated cyclically, but the useful data is continuously generated.

If one of the frames contains half rate slots (and so actually consists of 2 frames itself),
the repetition factor must be a multiple of 2 (see ​chapter 3.7, "Mode Framed (single)",
on page 26 ).

The frame structure of the two frames is displayed in graphical form. Slot parameters can
be defined in the burst editor, which is called when the slot is selected in the graphical
display (see ​chapter 3.12, "Burst Editor", on page 43 ).

Provided are also the following settings:

Save/Recall Frame …
Access the "Save/Recall Frame" dialog for selecting of predefined or user defined frames,
see ​chapter 3.9, "Save Recall Frame/Slots", on page 29 .

Remote command: 
n.a.

Mode Framed (double)
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Frame Repetition
Enters the number of repetitions for frame 1 or frame 2. First frame 1 is repeated the
specified number of times, and then frame 2, then frame 1 starts again, and so on.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​REPetitions ​ on page 63

3.9 Save Recall Frame/Slots

1. To access these dialogs select "General > Sequence Mode > Framed (Single) /
Framed (Double)".

2. Select "Framed (Single) / Framed (Double) Configuration" .

3. To access the "Save/Recall Frame" dialog, select "Save/Recall Frame"

4. To access the "Save/Recall Slots " dialog, select "Frame: Select Slot to configure >
Slot... > Save/Recall Slots"

The "File Select" dialogs save and load (i.e. recall) user-defined frames or slots. Prede-
fined frames or slots can also be recalled. Each dialog offer access to the "File Man-
ager" for general file management.

Predefined Frames and Slots are stored on a predefined path. This path is automatically
set in the "File Select" window.

In the Normal Symbol Rate mode, user-defined Frames and Slots are stored as files with
the specific file extensions *.gsm_fu or *.gsm_slu, respectively.

In the Higher Symbol Rate mode, user-defined Frames and Slots are stored as files with
the specific file extensions *.gsm_hfu or *.gsm_hslu, respectively. Independent of
the selected symbol rate mode, the files with user-defined Frames and Slots can be
stored in a user-determined directory and called from there.

It is not possible to use other file extensions. Attempting to do so will cause an error
message. If the file extension is modified (e.g. by directly accessing the file system) the
files are no longer recognized and therefore invalid.

In the following examples of commands the files are stored in the default directory which
is defined by command MMEM:CDIRectory.

Recall Predefined Frame/Slot
Access the standard "File Select" dialog for loading a predefined frame/slot.

"EDGE0" Predefined frame
slot 0 = On, full level, EDGE burst, all other slots off.

"EDGEAll" Predefined frame
all slots On, full level, EDGE burst

 

Save Recall Frame/Slots
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"GsmEdge" Predefined frame
alternately one slot with NORMAL burst and EDGE burst

"Normal-
Burst0"

Predefined frame
slot 0 = On, full level, NORMAL burst (full rate), all other slots off

"NormalBur-
stAll"

Predefined frame
all slots On, full level, NORMAL burst (full rate)

"GSM_NB_PN
9_TSC0"

Predefined slot
NORMAL burst (full rate), full level, attenuation A1, multislot = Off,
number of multislots = 1, Data = PRBS 9, Use Stealing Flag = On,
TSC0, all slot-marker set to "all down".

"GSM_NB_PN
9_TSC0"

Predefined slot
EDGE burst (full rate), full level, attenuation A1, multislot = Off, number
of multislots = 1, Data = PRBS 9, Use Stealing Flag = On, TSC0, all
slot-marker set to "all down"

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​PREDefined: ​CATalog? ​ on page 70
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​PREDefined: ​LOAD ​ on page 71
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​PREDefined: ​CATalog? ​ on page 71
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​PREDefined: ​LOAD ​ on page 72

Recall User Frame/Slot
Access the standard "File Select" dialog for loading a user-defined frame/slot.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​CATalog? ​ on page 69
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​LOAD ​ on page 70
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​CATalog? ​ on page 72
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​LOAD ​ on page 73

Save User Frame/Slot
Access the standard "File Select" dialog for saving the current frame or slot settings.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​STORe ​ on page 70
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​STORe ​ on page 73

File Manager
Access the standard "File Manager" dialog, used to copy, delete and rename files and to
create new directories.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​DELete ​ on page 69
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​DELete ​ on page 72

Save Recall Frame/Slots
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3.10 Modulation/Filter

1. To access this dialog select "Baseband > GSM/EDGE > General".

2. Select "Modulation/Filter...."

The parameters displayed depend on the selected "Symbol Rate Mode". The param-
eters are grouped in different sections, according to the modulation (MSK/FSK,
8PSK/EDGE, QPSK, AQPSK, 16QAM or 32QAM) they apply to.

"Higher Symbol Rate Mode", AQPSK modulation and higher order modulations (16QAM
and 32QAM) are available for instruments equipped with optionR&S SMW-K41 only.

3.10.1 General Settings

► To access this dialog select "General".

This dialog comprises the general modulation settings.

Provided are the following settings:

Symbol Rate
Sets the symbol rate. The symbol rate is determined by the selected "Symbol Rate
Mode".

For normal symbol rate mode, the default value for GSM/EDGE is 270.833 33 ksymb/s.

For higher symbol rate mode, the default value for EDGE Evolution is 325 ksymb/s.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SRATe ​ on page 67

Ignore 1/4 symbol (slot length 156 sym) / Ignore ½ symbol (slot length 187 sym)
Selects constant slot length. This setting affects all burst types.

 

 

Modulation/Filter



GSM/EDGE User InterfaceGSM/EDGE, EDGE Evolution

32User Manual 1175.6684.02 ─ 02

In a normal burst (NB), the GSM slot has a length of 156.25 symbols. Compensation for
the 1/4 symbol takes the form of an extra symbol every 4th slot. This means that some
slots are 156 long and some are 157 long. Compensation takes place in the guard field
of the burst (see ​chapter 3.12, "Burst Editor", on page 43 ).

In a higher symbol rate burst (HB), the average slot is 187.5 symbols long. Compensation
for ½ symbol means that each second slot gets an extra symbol and is 188 symbols long,
while the rest uses a slot length of 187 symbols.

If the field "Ignore 1/4 symbol (slot length 156 symbols) / Ignore ½ symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra 1/4
resp. ½ symbol is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is then 1496 symbols
long instead of 1500 symbols.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​ISLength ​ on page 63

Force Dummy Bits to 1
A modulating bit stream consisting of consecutive ones is used for inactive slots (accord-
ing to GSM 05.04). If this parameter is disabled, the inactive slots are filled in with 0.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FONE ​ on page 63

3.10.2 MSK/FSK Settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. To access this dialog select "MSK/FSK".

This dialog comprises the MSK/FSK modulation settings.

 

Modulation/Filter
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Modulation Type GSM
Selects modulation type for GSM signal.

"MSK 1bit/symbol" = Minimum Shift Keying

"FSK 1bit/symbol" = Frequency Shift Keying

The selected modulation is also displayed in graphical form.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FORMat ​ on page 74

FSK Deviation
Sets the deviation when selecting FSK.

When MSK is selected, the deviation is set permanently to symbol_rate/4.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FSK: ​DEViation ​ on page 74

Filter
Displays filter for GSM signal. The filter is permanently set to GAUSS.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​TYPE? ​ on page 78

Filter Parameter
Sets the BxT value for the GAUSS filter. The GSM default value is 0.3.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​PARameter ​ on page 78

3.10.3 AQPSK Settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. To access this dialog select "AQPSK".

 

Modulation/Filter



GSM/EDGE User InterfaceGSM/EDGE, EDGE Evolution

34User Manual 1175.6684.02 ─ 02

This dialog comprises the AQPSK modulation settings.

Modulation AQPSK
Displays modulation type for GSM signal. The modulation type is set permanently to
AQPSK (see ​chapter 2.1, "VAMOS (Voice services over Adaptive Multi-user channels
on One Slot)", on page 9).

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​FORMat? ​ on page 75

Angle alpha_0 ... alpha_7
Sets the angle alpha (see ​figure 2-2).

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​ANGLe<ch0> ​ on page 77

SCPIR_0 .. SCPIR_7
The power level of subchannel 1 relative to the power level of subchannel 2 is called
Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle α as follows:

SCPIR = 20 * log10(tan α) dB,

where the value of α shall be chosen such that |SCPIR|≤10dB

For α = 45° the SCPIR equals 0 dB and the two power levels are equal.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​SCPIR<ch0> ​ on page 77

Modulation/Filter
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Filter
Displays the filter type for AQPSK modulation. The filter is permanently set to GAUSS
linearized.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​AQPSK: ​TYPE? ​ on page 78

3.10.4 8 PSK / EDGE Settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. To access this dialog select "8 PSK/EDGE".

This dialog comprises the 8 PSK/EDGE modulation settings.

Modulation Type EDGE
Displays modulation type for EDGE signal. The modulation type is set permanently to
8PSK EDGE (3pi/8 8PSK). Unlike the modulation types for GSM the modulation type for
EDGE has 3 bits per symbol.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​EDGE: ​FORMat? ​ on page 74

Filter
Displays filter for EDGE signal. The filter is permanently set to GAUSS linearized.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​EDGE: ​TYPE? ​ on page 79

3.10.5 16QAM Settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. To access this dialog select "16 QAM".
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This dialog comprises the 16 QAM modulation settings.

Modulation Type 16QAM
Displays modulation type for signal.

The modulation type 16QAM has 4 bits per symbol.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​N16Qam: ​FORMat? ​ on page 76

Filter
Displays filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​N16Qam: ​TYPE? ​ on page 79

3.10.6 32QAM Settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. To access this dialog select "32 QAM".

This dialog comprises the 32 QAM modulation settings.
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Modulation Type 32QAM
Displays modulation type for signal.

The modulation type 32QAM has 5 bits per symbol.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​N32Qam: ​FORMat? ​ on page 76

Filter
Displays filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​N32Qam: ​TYPE? ​ on page 79

3.10.7 HSR QPSK Settings

1. To access this dialog select "Symbol Rate Mode > Higher Symbol Rate".

2. To access this dialog select "HSR QPSK".

This dialog comprises the HSR QPSK modulation settings.

Modulation Type HSR QPSK
(for Higher Symbol Rate only)

Displays modulation type for signal.

The modulation type QPSK EDGE has 2 bits per symbol.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​HQPSk: ​FORMat? ​ on page 76

Filter
(for Higher Symbol Rate only)

Displays the filters for HSR QPSK EDGE signal.
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The two possible filters are displayed. The currently used filter is set per HSR QPSK slot
with the parameter "Filter".

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 100
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​HQPSk: ​TYPE ​ on page 80

3.10.8 HSR 16QAM Settings

1. To access this dialog select "Symbol Rate Mode > Higher Symbol Rate".

2. To access this dialog select "HSR 16QAM".

This dialog comprises the HSR 16QAM modulation settings.

Modulation Type HSR 16QAM
(for Higher Symbol Rate only)

Displays modulation type for signal.

The modulation type 16QAM has 4 bits per symbol.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​H16Qam: ​FORMat? ​ on page 75

Filter
(for Higher Symbol Rate only)

Displays filter for HSR 16QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 16QAM
slot with the parameter Filter.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 100
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​H32Qam: ​TYPE ​ on page 80
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3.10.9 HSR 32QAM Settings

1. To access this dialog select "Symbol Rate Mode > Higher Symbol Rate".

2. To access this dialog select "HSR 32QAM".

This dialog comprises the HSR 32QAM modulation settings.

Modulation Type HSR 32QAM
(for Higher Symbol Rate only)

Displays modulation type for signal.

The modulation type 32QAM has 5 bits per symbol.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​H32Qam: ​FORMat? ​ on page 75

Filter
(for Higher Symbol Rate only)

Displays filter for 32QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 32QAM
slot with the parameter Filter.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 100
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​H32Qam: ​TYPE ​ on page 80

3.10.10 ARB Settings

1. To access this dialog select "Baseband > GSM/EDGE > General".

2. Select "Modulation/Filter.... > ARB"
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Provided are the follwoing settings:

Sequence Length ARB
Changes the sequence length of the arbitrary waveform component of the signal. This
component is calculated in advance and output in the arbitrary waveform generator. It is
added to the realtime signal components.

The maximum number of frames depends on the installed ARB waveform memory size
and the current "Symbol Rate".

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FLENgth ​ on page 62

3.11 Power Ramping/Slot Attenuation

1. To access this dialog select "Baseband > GSM/EDGE > General".

2. Select "Power Ramping/Slot Attenuation"

 

Power Ramping/Slot Attenuation



GSM/EDGE User InterfaceGSM/EDGE, EDGE Evolution

41User Manual 1175.6684.02 ─ 02

This dialog is used to enter the settings for power ramping and level attenuation. The
"Power Ramp Control" section is used for setting the power ramp envelope. The "Slot
Attenuations (Used in Burst Editors)" section is used to define seven possible values
for level attenuation. These values can be selected from the burst editor for the slot
currently being edited. An eight value is permanently set to 0 dB and corresponds to
the "Slot Level Full" setting in the burst editor. The "Power Ramping/ Level Attenua-
tion" section is used for restricting power ramping to the baseband signal.

Provided are the following settings:

Ramp Time
Enters the power ramping rise time and fall time for a burst. The setting is expressed in
symbols.

The transmitted power must not be switched abruptly at the start and end of a burst,
because the switching operation would otherwise generate excessively strong non-har-
monics; the switching operation is therefore stretched over several symbol clocks.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​TIME ​ on page 97

Ramp Function
Enters the form of the transmitted power during the switching operation, i.e. the shape of
the rising and falling edges of the envelope.

"Linear" The transmitted power rises and falls linear fashion.
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"Cosine" The transmitted power rises and falls with a cosine-shaped edge. This
gives rise to a more favorable spectrum than the Linear setting.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​SHAPe ​ on page 96

Rise Delay - Power Ramp Control
Sets the offset in the rising edge of the envelope at the start of a burst. A positive value
gives rise to a delay and a negative value causes an advance. The setting is expressed
in symbols.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​RDELay ​ on page 96

Fall Delay - Power Ramp Control
Sets the offset in the falling edge of the envelope at the end of a burst. A positive value
gives rise to a delay and a negative value causes an advance. The setting is expressed
in symbols.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​FDELay ​ on page 95

Slot Attenuation A1 to A7
Enters seven different values for level attenuation.

The burst editor can be used to set the level attenuation for the 8 slots to one of these
predefined values independently of one another.

The ability to set a sequence of slots purposely to different levels (loud - soft - loud) in
order to measure transmission stability is a requirement of measurement recommenda-
tion 11.21 in the latest GSM version 8.6.09.

The burst editor is likewise used to assign the "Slot Level" attribute "Attenuated" to indi-
vidual slots.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SATTenuation<ch> ​ on page 65

Baseband Only - Power Ramp Control
(Instruments with RF output only)

Restricts power ramping to the baseband signal.

"Off" Level attenuation is effected via the attenuator stages in the RF section;
only the remaining part is attenuated in the baseband. The signal is
issued at the RF output with the defined level values. This setting pro-
vides the best possible dynamic for bursted signals.
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"On" Level attenuation is effected in the baseband only.

This setting is mandatory in the following cases:
● When only the baseband signal is issued at the I/Q outputs. It is

thus ensured that, with power ramping active, this signal is output
with the defined level values.

● When a baseband signal is applied to two RF paths of an two-path
instrument. The RF paths having separate frequency and level set-
tings, the remaining attenuation to be effected in the baseband
would have to be different for the two paths and is therefore not
possible.

● When a bursted baseband signal (GSM/EDGE) is combined with a
continuous baseband signal (e.g. 3GPP) or a noise signal and both
signals are applied to one RF path of an two-path instrument.
Blanking in the RF paths is not suitable, because the RF section
would not only blank the bursted signal of the first baseband but
also the continuous signal of the second baseband or the noise
signal.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​BBONly[: ​STATe] ​ on page 95

3.12 Burst Editor

1. To access this dialog select "Unframed Configuration" or "Framed (Single) Configu-
ration" or "Framed (Double) Configuration".

2. Select a slot in the "Frame: Select Slot to Configure" section.
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This dialog comprises the settings for configuring a burst slot.

At the bottom of the "Burst Field " section the structure of the current burst type for the
selected slot is displayed. Individual fields of the burst are color-coded:

Field Color

Data, Fixed, Mixed, Stealing white

Training Sequences: TSC, ETSC, SYNC yellow

Tail, extended Tail green

Guard, extended Guard blue

The rest of the dialog displays the data contained in fields predefined by the standard for
the current burst type. Data fields with variable content can be edited. The value at which
they are currently set is shown on a button. Pressing the button activates the value that
has been entered. Values in fields with permanently predefined content are not highligh-
ted in any way.

This dialog changes according to the selected "Burst Type". The following sections list
all possible settings and displays for the various burst types. If a setting applies only to
a particular burst type, this is mentioned for the parameter concerned.

Burst Type
Selects burst type.
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The available burst types depend on the selected "Symbol Rate Mode".

Note: "Higher Symbol Rate Mode", AQPSK modulations and higher order modulation
schemes (16QAM and 32QAM) are available for instruments equipped with option
R&S SMW only.

"Normal (GMSK/Full Rate)"
(Normal Symbol Rate)
The useful data is transmitted in the Normal Burst (NB).
A normal burst carries 2*58 = 116 encrypted bits.

"Normal (GMSK/Half Rate)"
(Normal Symbol Rate)
The useful data is transmitted in the Normal burst.
Half rate user 1 is transmitted in all the frames with an even index
(frames 0, 2, 4, etc.) and half rate user 2 is transmitted in the frames
with an odd index (frames 1, 3, etc.)
See also ​chapter 3.7, "Mode Framed (single)", on page 26 .

"Normal (AQPSK/Full Rate - Full Rate)"
The data of pair of users is multiplexed on the two VAMOS subchannels
of a single physical radio resource.
See also ​chapter 2.1, "VAMOS (Voice services over Adaptive Multi-
user channels on One Slot)", on page 9.

"Normal (AQPSK/Full Rate - Half Rate)"
Three users are using the same radio resource, one full rate VAMOS
user on the subchannel 1 and two half rate VAMOS users on the sub-
channel 2.

"Normal (AQPSK/Half Rate - Half Rate)"
A single time slot is shared by four users: two VAMOS subchannels,
each used by two half rate users.

Burst Editor



GSM/EDGE User InterfaceGSM/EDGE, EDGE Evolution

46User Manual 1175.6684.02 ─ 02

"Normal
(8PSK/EDGE)"

(Normal Symbol Rate)
The higher bit clock associated with EDGE achieves correspondingly
higher data transfer rates.
If a frame contains an active EDGE burst, the higher bit clock (3 x sym-
bol clock) is always output on the clock outputs. If the EDGE burst is
removed from the frame, the lower bit clock (=symbol clock) is auto-
matically output again.
An EDGE burst carries 2x(3*58) = 348 encrypted bits.

"Normal (16QAM)"
(Normal Symbol Rate)
Selects a normal burst with 16QAM modulation scheme (4 bits per
symbol).
A normal 16QAM burst carries 2x(4*58) = 464 encrypted bits.

"Normal
(32QAM)"

(Normal Symbol Rate)
Selects a normal burst with 32QAM modulation scheme (5 bits per
symbol).
A normal 32QAM burst carries 2x(5*58) = 580 encrypted bits.

"Synchroniza-
tion"

(Normal Symbol Rate)
The Synchronization burst is sent by the base station only and is used
for bit synchronization. For this purpose it contains a 64-bit Extended
Training Sequence.

"Frequency
Correction"

(Normal Symbol Rate)
The Frequency Correction burst is sent by the base station only. The
user equipment uses the burst in order to synchronize with the carrier
frequency and to compensate for any possible Doppler effect.

"Dummy" (Normal Symbol Rate)
The Dummy burst is sent by the base station only. It acts as a modu-
lation signal when there is no data burst available. This burst type is
defined in the standard and has an unalterable, precisely defined data
pattern.
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"Access" (Normal Symbol Rate)
This burst type is sent by a user equipment to a base station as the first
burst, in order to determine the timing advance. It is used for synchro-
nizing with the base station.

"All Data
(GMSK)"

(Normal Symbol Rate)
This and the following normal symbol rate burst types are not defined
in the standard. They serve as the output basis for defining a new burst
type with user-programmable data content for test purposes.
An All_Data GMSK burst carries 148 encrypted bits.

"All Data
(AQPSK)"

An All_Data AQPSK burst carries 148 encrypted bits per subchannel.

"All Data
(8PSK/EDGE)"

(Normal Symbol Rate)
An All_Data EDGE burst carries 3x148 = 444 encrypted bits.

"All Data
(16QAM)"

(Normal Symbol Rate)
An All_Data 16QAM burst carries 4x148 = 592 encrypted bits.

"All Data
(32QAM)"

(Normal Symbol Rate)
An All_Data 32QAM burst carries 5x148 = 740 encrypted bits.

"HSR (QPSK)" (Higher Symbol Rate)
Selects a higher symbol rate burst with QPSK modulation scheme (2
bits per symbol).
A higher symbol rate burst carries 2*69 = 138 unmodulated encrypted
bits, i.e. a HSR QPSK burst carries 2x(2*69) = 276 encrypted bits.

"HSR
(16QAM)"

(Higher Symbol Rate)
Selects a higher symbol rate burst with 16QAM modulation scheme (4
bits per symbol).
A HSR 16QAM burst carries 4x(2*69) = 552 encrypted bits.
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"HSR
(32QAM)"

(Higher Symbol Rate)
Selects a higher symbol rate burst with 32QAM modulation scheme (5
bits per symbol).
A HSR 32QAM burst carries 5x(2*69) = 690 encrypted bits.

"HSR All Data
(QPSK)"

(Higher Symbol Rate)
This and the following higher symbol rate burst types are not defined in
the standard. They serve as the output basis for defining a new burst
type with user-programmable data content for test purposes.
A HSR All_Data QPSK burst carries 2x177 = 354 encrypted bits.

"HSR All Data
(16QAM)"

(Higher Symbol Rate)
A HSR All_Data 16QAM burst carries 4x177 = 708 encrypted bits.

"HSR All Data
(32QAM)"

(Higher Symbol Rate)
A HSR All_Data 32QAM burst carries 5x177 = 885 encrypted bits.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>: ​TYPE ​ on page 98

Save-Recall Slots
Calls the Save/Recall Slot dialog.

From the Save/Recall Slot dialog the File Select windows for saving and recalling slot
configurations and the File Manager can be called (see ​chapter 3.9, "Save Recall Frame/
Slots", on page 29).

Remote command: 
n.a.

User x
When burst type "Normal (Half Rate)" is selected the users can be set separately in dialog
sections User 1 and User 2.

Remote command: 
n.a.

SCPIR
Selects the SCPIR.
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Use the ​Modulation/Filter dialog to define eight different values for SCPIR. You may
select from the values displayed.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SCPIRatio ​ on page 99

Slot Level
Sets the level for the selected slot.

"Off" Attenuation is maximum. The slot is inactive.

"Attenuated" Level is reduced by the level attenuation set in "Slot Attenuation".

"Full" The level corresponds to the level indicated in the display.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​LEVel ​ on page 99

Slot Attenuation
Selects the level attenuation for the Slot Level Attenuated setting. You can use the "Power
Ramping" dialog (see ​chapter 3.11, "Power Ramping/Slot Attenuation", on page 40 ) to
define seven different values for level attenuation. You may select from the values dis-
played.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ATTenuation ​ on page 99

Filter
(for Higher Symbol Rate slots and instruments equipped with K41 only)

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter should be use for
the selected burst type and modulation.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 100

Multislot Configuration
Enables the previously set multislot mode.

Since multislot involves connecting multiple slots to a single user channel, this configu-
ration is possible for Normal (Full Rate) bursts, Normal (8PSK/EDGE) burst and EDGE
Evolution bursts.

A number of multislot groups can be defined within a frame. These are highlighted when
the frame structure is displayed in the main dialog (see ​chapter 3.7, "Mode Framed (sin-
gle)", on page 26).
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The first slot in a multislot group is the master slot. This determines the parameters of all
the slots in the group. All the slots in a multislot group therefore have identical parameters.

The multislot settings are valid for all the slots in the frames of a multiframe configuration.
If slots 1 and 2 are connected, for example, both these slots are connected in all the
frames of the multiframe signal.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​MULTislot<st0>: ​STATe ​ on page 103

Number of Slots
Defines the number of consecutive slots that will be linked to a multislot.

The multislot always starts with the current slot. The value range therefore depends on
the current slot index. A maximum of 8 slots (slot 0 to slot 7) can be combined: 1 ... (8 -
current index).

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​MULTislot<st0>: ​COUNt ​ on page 100

VAMOS Offset Jitter
Enables/disables the simulation of a timing jitter for GMSK bursts.

The test specification 3GPP TS 45.005, Annex Q5 defines that for uplink tests in VAMOS
mode, both interference and sensitivity limited cases are specified for VAMOS subchan-
nel 1 that is offset in time and frequency with respect to VAMOS subchannel 2. If this
parameter is activated, the instrument applys a timing offset (jitter) with randomly selected
value in the range of -1, 0 or 1 symbol period. The timing offset changes between the
bursts; within a burst, the instrument keeps the time and frequency offsets constant.

The random function for applying of the frequency offset will be implemented in future
firmware version.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>: ​VOJitter ​ on page 101

Burst Fields
Comprises settings for configuring of the individual burst fields.
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The available settings depends on the selected ​Burst Type.

Extended Tail Bits ← Burst Fields
Displays the data content in the "ETail" data field of the Access burst.

Extended Tail Bits fields are 8 bits long and permanently set at 0011 1010.

Remote command: 
n.a.

Tail Bits ← Burst Fields
Displays the data content in the "Tail" data field.

The content depends on the "Burst Type":
● Normal (GMSK...), Normal (AQPSK...), Synchronization, Frequency Correction,

Dummy and Access
"Tail Bit" field is 3 Bits long and permanently set at 000.

● Normal(8PSK/EDGE)
"Tail Bit" field is 9 Bits long and permanently set at 1 1111 1111.

● Normal (16QAM)
"Tail Bit" field is 12 Bits long and permanently set at 0001 0110 0110.
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● Normal (32QAM)
"Tail Bit" field is 15 Bits long and permanently set at 111 1001 1100 1110.

Remote command: 
n.a.

Data for Data Field of Slot ← Burst Fields
Selects a data source for the DATA field.

If a burst contains multiple DATA fields, these are treated as a continuous field, and for
instance a pseudo-random sequence is continued without interruption from one DATA
field to the next.

You may choose from the following data sources:

"All 0, All1" 0 data or 1 data is internally generated.

"PRBS" PRBS data in accordance with the IUT-T with period lengths between
29-1 and 223-1 are internally generated.

"Pattern" A user-definable bit pattern with a maximum length of 64 bits is inter-
nally generated.
The bit pattern is defined in the "Pattern" input box.

"Data List" Uses data from a programmable data list. The data can be generated
internally with the aid of the binary editor in the R&S Signal Generator
or externally by the user with the aid of any editor.
Data lists are selected from the Select List file dialog.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA ​ on page 101
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​PATTern ​ on page 103
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt: ​CATalog? ​ on page 103
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt ​ on page 102

Use Stealing Flag ← Burst Fields
Sets the Use Stealing Flag feature. The setting applies to both S fields. If not used, the
flag stealing bit is allocated to the data field concerned, which then becomes 58 data bits
long instead of 57.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SFLag: ​USE ​ on page 104

Stealing Flag ← Burst Fields
Sets a value for the Stealing Flag feature. The setting applies to both S fields.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SFLag ​ on page 104
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Training Sequence Set ← Burst Fields
Determine whether the GMSK normal burst or VAMOS subchannel uses TSC set 1 or
set 2.

Assign different TSC set to each of the two subcahnnels to ensure that the training
sequences configured for the VAMOS subchannels have a very low cross-correlation.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​TSC: ​SET ​ on page 105

TSC ← Burst Fields
Selects the "Training Sequence Code".

There are 8 predefined training sequences to choose from in each case; those for GSM
are 26 bits long and those for EDGE are 78 bits.

A user-defined training sequence can be created in the User TSC field and is then also
available for selection.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​TSC: ​SELect ​ on page 105

TSC Pattern ← Burst Fields
Edits selected training sequence.

When a sequence has been changed, the TSC field displays the indication "User".

When a frame/slot is saved the amended training sequence is also saved.

User-defined training sequences can be used among other things to test the reaction of
receivers to interference-laden training sequences (e.g. 1 bit toggle).

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​TSC: ​USER ​ on page 105

Ext Training Seq ETSC ← Burst Fields
Selects the Extended Training Sequence Code for the Synchronization burst.

There is a choice of three predefined, 64-bit extended training sequences. Additionally a
user-defined extended training sequence can be defined in the User ETSC field and is
then also available for selection.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ETSC ​ on page 106

ETSC Pattern ← Burst Fields
Edits selected ETSC for the Synchronization burst.

When a sequence has been changed, the "Ext Training Seq ETSC" field also displays
"User" as a possible choice.
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When a frame/slot is saved, the changed extended training sequence is also saved.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ETSC: ​USER ​ on page 106

Training Sequence Sync ← Burst Fields
Selects Training Sequence Sync for the "Access" burst.

There is a choice of three predefined, 41-bit training sequences sync. Additionally user-
defined training sequence sync can be defined in the "User Sync" field and is then also
available for selection.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SYNC: ​SELect ​ on page 106

Sync Pattern ← Burst Fields
Edits the Training Sequence Sync for the Access burst.

When a sequence has been changed, the "Training Sequence Sync" field also displays
"User" as a possible choice.

When a frame/slot is saved the amended training sequence sync is also saved.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SYNC: ​USER ​ on page 107

Fixed ← Burst Fields
Selects the data content of the Fixed field in the Frequency Correction burst. There is a
choice of two fixed, 142-bit data contents prescribed by the standard. The "User" data
content can also be selected. This pattern can be edited in the Fixed Pattern field and
must likewise be 142 bits long.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FCORrection: ​FIXed ​ on page 107

Fixed Pattern ← Burst Fields
Displays the data content of the Fixed field in the Frequency Correction burst when "Fixed
Standard" or "Compact" is selected.

Enter the data content of the Fixed field in the Frequency Correction burst when "Fixed
User" is selected. The pattern is 142 bits long.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FCORrection: ​FIXed: ​PATTern ​ on page 107

Burst Editor
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Mixed ← Burst Fields
Displays the data content of the Mixed field in the Dummy burst. It contains a fixed, 142-
bit data content prescribed by the standard.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​DUMMy: ​MIXed: ​PATTern? ​ on page 108

Guard ← Burst Fields
Displays the data content of the Guard field in binary notation.

In order for a frame to contain exactly 1250 bits for normal burst and 1500 for higher
symbol rate burst as prescribed in the GSM standard, the length of the Guard fields is
different for different slots (see table).

 Normal Symbol Rate  

Slot # 0, 4 1 .. 3, 5 .. 7

Guard Length 9 symbol periods 8 symbol periods

 Higher Symbol Rate  

Slot # 0, 2, 4, 6 1, 3, 5, 7

Guard Length 11 symbol periods 10 symbol periods

If the field Ignore "1/4 symbol (slot length 156 symbols) / Ignore ½ symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra 1/4
resp. 1/2 symbols is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is then 1496 symbols
long instead of 1500 symbols.

Remote command: 
n.a.

Extended Guard ← Burst Fields
Displays the data content of the Extended Guard field in the Access burst.

In order for a frame to contain exactly 1250 symbols as prescribed in the GSM standard,
the length of the extended Guard fields is different for different slots:

The field length is 68 bits in slots 1, 2, 3, 5, 6, 7 and 69 bits in slots 0 and 4.

If the field "Ignore 1/4 symbol (slot length 156 symbols)" is enabled, all slots are 156
symbols long. The extra 1/4 symbol is omitted. The extended guard field for the burst
always has the same length regardless of the slot index. A frame is therefore 1248 sym-
bols long in place of 1250.

Remote command: 
n.a.

Burst Editor
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Slot Marker Definition
Access the dialog for defining the marker signal at slot level. This dialog is described in
the ​chapter 3.13, "Slot Marker Definition", on page 56 .

Remote command: 
n.a.

3.13 Slot Marker Definition

1. To access these dialogs select "General > Sequence Mode > Framed (Single) /
Framed (Double)".

2. Select "Framed (Single) / Framed (Double) Configuration" .

3. Select "Frame: Select Slot to configure > Slot... > Burst Type (Dialog)"

4. Select "Slot Marker Definition"

This dialog displays the structure of the slot and comprises the settings for configuring
a ramp.

The marker signals thus defined will only become effective if the "As defined in slot"
marker type in the "Trigger/Marker/Clock dialog" is selected.

The structure of the selected slot (in the example, synchronization burst) is displayed in
the dialog header. The individual fields of the burst are color-coded.

The available marker signals are also color-coded. In the left "Configure Control Sig-
nal" section, each individual signal is assigned a color; a check in the check box shows
the marker for which the "As defined in slot" marker type has been selected.
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In the next section, "Select Ramp to Edit", the signal characteristics are graphically dis-
played.

The ramps can be assigned the exact bit position in the signal by means of
● The schematic display of the slot above the section.
● The bit scale below the marker/control signal characteristic.
● The display of the current cursor position in the "Cursor" dialog section if the cursor

marks the ramp. The field at the selected position in the slot is displayed on the side.
The bit position of the cursor within this field is displayed below

The ramps can be set either graphically in the "Select Ramp to Edit" section or in the
table of the "Positions Marker x" section. To make the setting easy, a selection of preset
ramp characteristics is offered in the "Preset Ramp Marker x" section.

Provided are the following settings:

Configure Control Signal
Displays the color the marker and the Burst Gate signal has been assigned.

Displays whether the "CList" marker type has been selected in the Trigger/Marker/Clock
dialog for this marker.

Displays whether the "As defined in Slot" source has been selected for this marker signal
in the individual setting dialog.

The source can be selected here as well and will then be used in the associated dialogs.

Note: The burst gate signal is only displayed and cannot be edited.

Remote command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​USER<ch>]: ​TRIGger: ​
OUTPut: ​TAG? ​ on page 108

Select Ramp to Edit
Graphically edit marker signals.

For this purpose, the cursor is set to the position where a ramp is required. The ramp is
generated by pressing Enter (e.g. clicking on the rotary knob). Any number of ramps can
be defined per marker. Each of the generated ramp positions will be saved even if the
definition of another ramp produces a low/low or high/high transition. The ramps are dis-
played as dashed lines.

Existing ramps can be shifted after the cursor has been placed on the ramp and Enter
has been pressed – it then changes color twice. The ramp is shifted by using the cursor
keys or the rotary knob. The new position is determined by pressing Enter again.

Ramps can be deleted by means of the BACKSPACE key after the cursor has been
placed on the ramp.

Remote command: 
n.a.

Total List Length
Displays the length of the list in bits.

Remote command: 
n.a.
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Preset Type
Activates presetting for the ramp characteristic of the selected control signal. The pre-
setting is selected with select "Preset Type" and activated by means of the "Preset" but-
ton.

You can select from:

"All Up" The marker signal is continuously high.

"All Down" The marker signal is continuously low.

"Ramp Up" The marker signal contains a ramp from low to high. The ramp is shifted
to the center of the displayed signal area and can subsequently be
shifted as required.

"Ramp Down" The marker signal contains a ramp from high to low. The ramp is shifted
to the center of the displayed signal area and can subsequently be
shifted as required.

"Ramp Up/
Down"

The marker signal contains a ramp from low to high and from high to
low. The ramps are symmetrically shifted around the center of the dis-
played signal area and can subsequently be shifted as required.

"Ramp Down/
Up"

The marker signal contains a ramp from high to low and from low to
high. The ramps are symmetrically shifted around the center of the dis-
played signal area and can subsequently be shifted as required.

Remote command: 
n.a.

Edit Table
Opens table by using the "Edit Table" button.

The ramps of the selected signal can be edited in the table. When the table is opened,
the current configuration of the selected marker/control signal is displayed.

Slot Marker Definition
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The bit position is specified in the "Ramp Position" column, the high or low signal status
in the "Ramp State" column. At the end of the list, there is always a blank row for entering
new values.

The changes are accepted in the graphic display after pressing the "Accept" button.

Remote command: 
n.a.

Cursor Position
Enters the cursor position.

In the graphic display, the cursor is positioned according to the entry.

Vice versa, graphically shifting the cursor will change the displayed value.

The field at the selected position in the slot is displayed on the side. The bit position of
the cursor within this field is displayed below.

Remote command: 
n.a.

Zoom/Visible
Zooms the displayed area of the control list. The designation of the button changes from
"Zoom in" to "Zoom out".

With long control lists, the displayed area can be zoomed around the current "Cursor
Position".

Slot Marker Definition
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Parameter "Visible/Bits Visible" determines the number of symbols/bits to be displayed.

Ramps outside the displayed area are not lost by zooming.

Remote command: 
n.a.

Save
Saves the settings made in the "Slot Marker" dialog into a file with file name format
GsmMarkSlotDefP<x>F<y>S<z>U<w>.dm_iqc, where:
● x the path number,
● y is the Frame number,
● z is the Slot number and
● w is the User number.

Remote command: 
n.a.

Slot Marker Definition
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4 Remote-Control Commands
The following commands are required to perform signal generation with the GSM/EDGE
options in a remote environment. We assume that the R&S SMW has already been set
up for remote operation in a network as described in the R&S SMW documentation. A
knowledge about the remote control operation and the SCPI command syntax are
assumed.

The R&S Signal Generator can be used to define multiframe signals. This requires the
inclusion of the keyword FRAMe in the commands concerned. However, this keyword is
optional in the case of single-frame signals.

In Frame (Double) mode (SOURce:BB:GSM:MODE DOUBle) the suffix to FRAMe defines
the frame to which the setting applies.

In Frame (Single) mode the keyword FRAMe is ignored and can be omitted.

The suffix to SLOT defines the slot to which the setting applies. The 8 slots of which a
frame is composed can be selected.

In case of remote control, suffix counting for slots corresponds to the suffix counting with
GSM (slot 0 to slot 7). SCPI prescribes that suffix 1 is the default state and used when
no specific suffix is specified. Therefore, slot 1 (and not slot 0) is selected when no suffix
is specified.

When burst type HALF is selected, the suffix to USER defines the half rate user to which
the setting applies. For all other burst types the keyword USER is ignored and can be
omitted.

The suffix to SUBChannel distinguish between the VAMOS subchannels. For all other
burst types the keyword SUBChannel is ignored and can be omitted.

Common Suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] .. 4 available baseband signals

OUTPut<ch> [1] .. 3 available markers

FRAMe<di> [1]|2 available frames

SLOT<st0> 0|[1] .. 7 available slots

SUBChannel<us> [1]|2 determines the VAMOS subchannel

USER<ch> [1]|2 available user in a half rate mode
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Basic tasks that are also performed in the base unit in the same way are not described
here.
For a description of such tasks, see the R&S SMW User Manual.
In particular, this includes:
● Managing settings and data lists, i.e. storing and loading settings, creating and

accessing data lists, etc.
● Information on regular trigger, marker and clock signals as well as filter settings, if

appropriate.
● General instrument configuration, e.g. checking the system configuration, configuring

networks and remote operation
● Using the common status registers

The following commands specific to the GSM/EDGE are described here:

4.1 Primary Commands

[:​SOURce<hw>]: ​BB:​GSM:​SLENgth ​...................................................................................62
[:​SOURce<hw>]: ​BB:​GSM:​FLENgth ​....................................................................................62
[:​SOURce<hw>]: ​BB:​GSM:​FONE​.......................................................................................63
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​REPetitions ​.............................................................63
[:​SOURce<hw>]: ​BB:​GSM:​ISLength ​...................................................................................63
[:​SOURce<hw>]: ​BB:​GSM:​MODE​.......................................................................................64
[:​SOURce<hw>]: ​BB:​GSM:​PRESet ​.....................................................................................64
[:​SOURce<hw>]: ​BB:​GSM:​SATTenuation<ch> ​.....................................................................65
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​CATalog? ​.....................................................................65
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​DELete ​........................................................................65
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​LOAD ​..........................................................................66
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​STORe​........................................................................66
[:​SOURce<hw>]: ​BB:​GSM:​SMODe ​.....................................................................................66
[:​SOURce<hw>]: ​BB:​GSM:​SRATe ​......................................................................................67
[:​SOURce<hw>]: ​BB:​GSM:​SRATe:​MODE​...........................................................................67
[:​SOURce<hw>]: ​BB:​GSM:​STATe​......................................................................................68
[:​SOURce<hw>]: ​BB:​GSM:​WAVeform:​CREate ​.....................................................................68

[:SOURce<hw>]:BB:GSM:SLENgth <SLength>
[:SOURce<hw>]:BB:GSM:FLENgth <FLength>

Sets the sequence length of the generated arbitrary waveform file in number of frames.

Parameters:
<FLength> float

Manual operation: See "Sequence Length ARB" on page 40
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[:SOURce<hw>]:BB:GSM:FONE <FOne>

A modulating bit stream consisting of consecutive ones is used for inactive slots (accord-
ing to GSM 05.04).

If this parameter is disabled, the inactive slots are filled in with 0.

Parameters:
<FOne> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:FONE ON
A modulating bit stream consisting of consecutive ones is used for
inactive slots.

Manual operation: See "Force Dummy Bits to 1" on page 32

[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPetitions <Repetitions>

The command defines the number of repetitions for the selected frame in GSM mode
Frame (Double).

Parameters:
<Repetitions> integer

Range: 1  to  500000
*RST: 1 / 1

Example: BB:GSM:MODE DOUB
selects GSM mode Frame (Double).
BB:GSM:FRAM2:REP 10
sets 10 repetitions for frame 2.

Manual operation: See "Frame Repetition" on page 29

[:SOURce<hw>]:BB:GSM:ISLength <ISLength>

Selects constant slot length.

For Normal Symbol Rate mode, the command selects whether the 1/4 symbol of a GSM
slot (length = 156.25 symbols) will be ignored (ON) or compensated for by an extra symbol
every 4th slot (OFF). When ON is selected, all slots are 156 symbols long. When OFF is
selected, some slots are 157 symbols long.

For Higher Symbol Rate mode, the command selects whether the 1/2 symbol of a aver-
age slot with a length of 187.5 symbols will be ignored (ON) or compensated for by an
extra symbol every secend slot (OFF). When ON is selected, all slots are 187 symbols
long. When OFF is selected, some slots are 188 symbols long.

Parameters:
<ISLength> 0 | 1 | OFF | ON

*RST: OFF
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Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:ISL ON
selects a constant length of 156 symbols for all slots.

Manual operation: See "Ignore 1/4 symbol (slot length 156 sym) / Ignore ½ symbol
(slot length 187 sym)" on page 31

[:SOURce<hw>]:BB:GSM:MODE <Mode>

The command selects GSM mode.

Parameters:
<Mode> UNFRamed | SINGle | DOUBle | MULTiframe

UNFRamed
Modulation signal without slot and frame structure.
SINGle
Modulation signal consisting of one frame.
DOUBle
Modulation signal in which two frames are defined and then com-
bined by some method into a single multiframe signal.
MULTiframe
Multiframe signal.
*RST: SINGle

Example: BB:GSM:MODE SING
sets the "Single Frame" GSM mode. Only the commands for defin-
ing a single frame are valid.

Manual operation: See "Sequence Mode" on page 14

[:SOURce<hw>]:BB:GSM:PRESet

The command sets all modulation parameters, including slot settings, to their GSM
default values. The ON status (SOURce:BB:GSM:STATe ON | OFF) is not affected by
this command.

Example: BB:GSM:PRES
resets all GSM settings to default values.

Usage: Event

Manual operation: See "Set to Default" on page 12

Primary Commands
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[:SOURce<hw>]:BB:GSM:SATTenuation<ch> <SAttenuation>

The command sets up to seven different values for level attenuation. The various values
are defined by the suffix to SATTenuation. These values are used when defining the
level attenuation of individual slots with the aid of the command ​[: ​SOURce<hw>]: ​BB: ​
GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​USER<ch>]: ​
ATTenuation ​.

Parameters:
<SAttenuation> float

Range: 0  to  60 dB
Increment: 0.01 dB
*RST: 0 dB

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT
sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB
sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT A1
sets the level attenuation for slot 1 to 12 dB.

Manual operation: See "Slot Attenuation A1 to A7" on page 42

[:SOURce<hw>]:BB:GSM:SETTing:CATalog?

This command reads out the files with GSM settings in the default directory. The default
directory is set using command MMEM:CDIRectory. Only files with the file extension
*.gsm will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR "/var/user/temp/dig_mod
sets the default directory to /var/user/temp/dig_mod.
BB:GSM:SETT:CAT?
reads out all the files with GSM settings in the default directory.
Response: gsm_1

Usage: Query only

Manual operation: See "Save/Recall" on page 13

[:SOURce<hw>]:BB:GSM:SETTing:DELete <Filename>

This command deletes the selected file with GSM settings. The directory is set using
command MMEM:CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension may be omitted. Only files with the file
extension *.gsm will be deleted.

Primary Commands
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Setting parameters: 
<Filename> string

Example: BB:GSM:SETT:DEL 'gsm_1'
deletes file gsm_1.

Usage: Setting only

Manual operation: See "Save/Recall" on page 13

[:SOURce<hw>]:BB:GSM:SETTing:LOAD <Filename>

This command loads the selected file with GSM settings. The directory is set using com-
mand MMEM:CDIRectory. A path can also be specified, in which case the files in the
specified directory are read. The file extension may be omitted. Only files with the file
extension *.gsm will be loaded.

Setting parameters: 
<Filename> string

Example: BB:GSM:SETT:LOAD 'gsm_1'
loads file gsm_1

Usage: Setting only

Manual operation: See "Save/Recall" on page 13

[:SOURce<hw>]:BB:GSM:SETTing:STORe <Filename>

This command stores the current GSM settings into the selected file. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. GSM settings
are stored as files with the specific file extensions *.gsm.

Setting parameters: 
<Filename> string

Example: BB:GSM:SETT:STOR 'gsm_1'
stores the current GSM settings into file gsm_1.

Usage: Setting only

Manual operation: See "Save/Recall" on page 13

[:SOURce<hw>]:BB:GSM:SMODe <SMode>

The command selects the modulation signal for the mode Unframed (:BB:GSM:MODE
UNFR). The modulation type and filter type are set in accordance with the selection.

The available simulation modes depend on the selected symbol rate:
● Normal Symbol Rate - GSM, EDGE (8PSK), AQPSK, 16QAM and 32QAM
● Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.
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Note:"Higher Symbol Rate" Mode and "Simulation Modes" AQPSK, 16QAM, 32QAM,
HSR QPSK, HSR 16QAM and HSR 32QAM are available for instruments equipped with
option R&S SMW-K41 only.

Parameters:
<SMode> GSM | EDGE | N16Qam | N32Qam | HQPSk | H16Qam | H32Qam |

AQPSk
*RST: GSM

Example: BB:GSM:MODE UNFR
sets unframed mode.
BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:SMOD H16Q
selects a HSR 16QAM modulation signal for the Unframed mode.
BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:SMOD GSM
selects a GSM modulation signal for the Unframed mode.

Options: N16Qam | N32Qam | HQPSk | H16Qam | H32Qam | AQPSk
require R&S SMW-K41

Manual operation: See "Simulation Mode" on page 14

[:SOURce<hw>]:BB:GSM:SRATe <SRate>

The command sets the symbol clock. Possible units are Hz, kHz, MHz, Sym/s, kSym/s,
MSym/s.

Parameters:
<SRate> float

Range: 400 Hz  to  25 MHz
Increment: 0.001 Hz
*RST: 270.833 kHz
Default unit: Hz

Example: BB:GSM:SRAT 270.9 kHz
sets the symbol clock to 270.9 kHz.

Manual operation: See "Symbol Rate" on page 31

[:SOURce<hw>]:BB:GSM:SRATe:MODE <Mode>

Set the symbol rate mode, i.e. determines whether a normal bursts (NB) or higher symbol
rate bursts (HB) will be generated.

Parameters:
<Mode> NSRate | HSRate

*RST: NSRate
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Example: BB:GSM:SRAT HSR
selects higher symbol rate mode
BB:GSM:SRAT?
queries the symbol clock.
Response: 325

Options: (for instruments equipped with option K41 only)

Manual operation: See "Symbol Rate Mode" on page 14

[:SOURce<hw>]:BB:GSM:STATe <State>

The command switches on the modulation in accordance with the GSM standard. Any
other standards or digital modulation that may be in the ON state will be automatically
turned OFF (in case of two-path instruments, this affects the same path).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:STAT ON
switches GSM modulation on.

Manual operation: See "State" on page 12

[:SOURce<hw>]:BB:GSM:WAVeform:CREate <Filename>

for R&S WinIQSIM2 only

This command creates a waveform using the current settings of the GSM/EDGE menu.
The file name is entered with the command. The file is stored with the predefined file
extension *.wv. The file name and the directory it is stored in are user-definable.

Setting parameters: 
<Filename> string

Example: MMEM:CDIR '/var/user/temp/waveform'
sets the default directory to /var/user/temp/waveform.
BB:GSM:WAV:CRE 'gsm_1'
creates the waveform file gsm.wv in the default directory.

Usage: Setting only

Manual operation: See "Generate Waveform File…" on page 14

4.2 Save Recall Frame/Slots

FRAMe<di>
Value range [1]|2
SLOT<st0>
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Value range 0|[1] .. 7
USER<ch>
Value range [1]|2
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​CATalog? ​.......................................................69
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​DELete ​..........................................................69
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​LOAD ​............................................................70
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​STORe​..........................................................70
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​PREDefined: ​CATalog? ​...........................................70
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​PREDefined: ​LOAD ​.................................................71
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

PREDefined: ​CATalog? ​...........................................................................................71
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

PREDefined: ​LOAD ​.................................................................................................72
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ULISt:​CATalog? ​.....................................................................................................72
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ULISt:​DELete ​........................................................................................................72
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ULISt:​LOAD ​..........................................................................................................73
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ULISt:​STORe​........................................................................................................73

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:CATalog?

This command reads out the files with user defined frame settings in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.gsm_fu and *.gsm_hfu will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR "/var/user/temp/frames"
sets the default directory to /var/user/temp/frames.
BB:GSM:FRAM:ULIS:CAT?
reads out all the files with user defined frame settings in the default
directory.
Response: 'NB_all'
the file NB_all with a user defined frame setting is available.

Usage: Query only

Manual operation: See "Recall User Frame/Slot" on page 30

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELete <Filename>

This command deletes the selected file with user defined frame settings. The directory
is set using command MMEM:CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension may be omitted. Only files
with the file extension *.gsm_fu and *.gsm_hfu will be deleted.

Save Recall Frame/Slots
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Setting parameters: 
<Filename> string

Example: BB:GSM:FRAM:ULIS:DEL 'NB_all'
deletes file NB_all.

Usage: Setting only

Manual operation: See "File Manager" on page 30

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:LOAD <Filename>

This command loads the selected file with user defined frame settings. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_fu and *.gsm_hfu will be loaded.

Setting parameters: 
<Filename> string

Example: BB:GSM:FRAM:ULIS:LOAD 'NB_all'
loads file NB_all.

Usage: Setting only

Manual operation: See "Recall User Frame/Slot" on page 30

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:STORe <Filename>

This command stores the current frame settings into the selected file. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. User Stand-
ards are stored as files with the specific file extensions *.gsm_fu and *.gsm_hfu.

Setting parameters: 
<Filename> string

Example: BB:GSM:FRAM:ULIS:STOR 'EDGE_all'
stores the current frame settings into file EDGE_all.

Usage: Setting only

Manual operation: See "Save User Frame/Slot" on page 30

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATalog?

This command reads out the files with predefined frame settings. The directory is preset,
therefore a path cannot be specified.

Return values: 
<Catalog> string
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Example: BB:GSM:FRAM:PRED:CAT?
reads out all the files with predefined frame settings.
Response: 'Edge0, EdgeAll, GsmEdge,
NormalBurst0, NormalBurstAll'
the file names of the files with the predefined frame settings are
returned

Usage: Query only

Manual operation: See "Recall Predefined Frame/Slot" on page 29

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined frame settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters: 
<Filename> string

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SRAT:MODE NSR
selects normal symbol rate.
BB:GSM:FRAM:PRED:LOAD 'Edge0'
loads file Edge0 with the predefined frame setting Edge Burst in
Slot 0.

Usage: Setting only

Manual operation: See "Recall Predefined Frame/Slot" on page 29

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:PREDefined:CATalog?

This command reads out the files with predefined slot settings. The directory is preset,
therefore a path cannot be specified.

The numeric suffixes in all key words are irrelevant for this command.

Return values: 
<Catalog> string

Example: BB:GSM:SLOT:PRED:CAT?
reads out all the files with predefined frame settings.
Response: GSM_NB_PN9_TSC0,EDGE_NB_PN9_TSC0
the files GSM_NB_PN9_TSC0 and EDGE_NB_PN9_TSC0 are avail-
able.

Usage: Query only

Manual operation: See "Recall Predefined Frame/Slot" on page 29
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined slot settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:PRED:LOAD 'GSM_NB_PN9_TSC0'
loads the settings of file GSM_NB_PN9_TSC0 for slot 1 in frame 1.

Usage: Setting only

Manual operation: See "Recall Predefined Frame/Slot" on page 29

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:CATalog?

This command reads out the files with user defined slot settings in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.gsm_slu and *.gsm_hslu will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/temp/slots
sets the default directory to /var/user/temp/slots.
BB:GSM:SLOT:ULIS:CAT?
reads out all the files with user defined slot settings in the default
directory.
Response: 'test_01'
the file test_01 with a user defined slot setting is available.

Usage: Query only

Manual operation: See "Recall User Frame/Slot" on page 30

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:DELete <Filename>

This command deletes the selected file with user defined slot settings. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_slu and *.gsm_hslu will be deleted.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:ULIS:DEL 'NB'
deletes file NB.

Usage: Setting only

Manual operation: See "File Manager" on page 30
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:LOAD <Filename>

This command loads the selected file with user defined slot settings. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_slu and *.gsm_hslu will be loaded.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:ULIS:LOAD 'NB'
loads file NB.

Usage: Setting only

Manual operation: See "Recall User Frame/Slot" on page 30

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:STORe <Filename>

This command stores the current slot settings into the selected file. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. User slots
are stored as files with the specific file extensions *.gsm_slu and *.gsm_hslu.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:ULIS:STOR 'EDGE'
stores the current slot settings into file EDGE.

Usage: Setting only

Manual operation: See "Save User Frame/Slot" on page 30

4.3 Modulation/Filter Settings

4.3.1 Modulation Settings

[:​SOURce<hw>]: ​BB:​GSM:​FORMat​....................................................................................74
[:​SOURce<hw>]: ​BB:​GSM:​EDGE:​FORMat?​........................................................................74
[:​SOURce<hw>]: ​BB:​GSM:​FSK:​DEViation ​...........................................................................74
[:​SOURce<hw>]: ​BB:​GSM:​AQPSk:​FORMat?​.......................................................................75
[:​SOURce<hw>]: ​BB:​GSM:​H16Qam: ​FORMat?​.....................................................................75
[:​SOURce<hw>]: ​BB:​GSM:​H32Qam: ​FORMat?​.....................................................................75
[:​SOURce<hw>]: ​BB:​GSM:​HQPSk:​FORMat?​.......................................................................76
[:​SOURce<hw>]: ​BB:​GSM:​N16Qam: ​FORMat?​.....................................................................76
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[:​SOURce<hw>]: ​BB:​GSM:​N32Qam: ​FORMat?​.....................................................................76
[:​SOURce<hw>]: ​BB:​GSM:​AQPSk:​ANGLe<ch0> ​.................................................................77
[:​SOURce<hw>]: ​BB:​GSM:​AQPSk:​SCPIR<ch0> ​..................................................................77

[:SOURce<hw>]:BB:GSM:FORMat <Format>

The command selects the modulation type.

Parameters:
<Format> MSK | FSK2

*RST: MSK

Example: BB:GSM:FORM FSK2
selects the GSM modulation type FSK.

Manual operation: See "Modulation Type GSM" on page 33

[:SOURce<hw>]:BB:GSM:EDGE:FORMat?

The command queries the modulation type in the case of EDGE. The modulation type is
permanently set to 8PSK.

Return values: 
<Format> P8EDge

*RST: P8EDge

Example: BB:GSM:EDGE:FORM?
queries the modulation type.
Response: "P8ED"

Usage: Query only

Manual operation: See "Modulation Type EDGE" on page 35

[:SOURce<hw>]:BB:GSM:FSK:DEViation <Deviation>

Sets the modulation deviation when :BB:GSM:FORMat FSK2 is selected.

The range of values depends on the symbol rate (:BB:GSM:SRATe). The maximum
deviation is 10 MHz.

Parameters:
<Deviation> float

Range: 0.1xf(symb)  to  1.5xf(symb);(10MHz)
Increment: 0.1
*RST: 67708.3333
Default unit: Hz

Example: BB:GSM:FORM FSK2
selects the GSM modulation type GFSK.
BB:GSM:FSK:DEV 37.6 kHz
sets the FSK deviation to 37.6 kHz.

Manual operation: See "FSK Deviation" on page 33
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[:SOURce<hw>]:BB:GSM:AQPSk:FORMat?

The command queries the modulation type. The modulation type is permanently set to
AQPSK.

Return values: 
<Format> AQPSk

*RST: AQPSk

Example: BB:GSM:AQPS:FORM?
queries the modulation type.
Response: "AQPSk"

Usage: Query only

Options: R&S SMW-K41

Manual operation: See "Modulation AQPSK" on page 34

[:SOURce<hw>]:BB:GSM:H16Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM16EDge

*RST: QAM16EDge

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:H16Q:FORM?
queries the modulation type.
Response: "QAM16ED"

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

Manual operation: See "Modulation Type HSR 16QAM" on page 38

[:SOURce<hw>]:BB:GSM:H32Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM32EDge

*RST: QAM32EDge

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:H32Q:FORM?
queries the modulation type.
Response: QAM32ED

Usage: Query only
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Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

Manual operation: See "Modulation Type HSR 32QAM" on page 39

[:SOURce<hw>]:BB:GSM:HQPSk:FORMat?

The command queries the modulation type.

Return values: 
<Format> QEDGe

*RST: QEDGe

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:HQPS:FORM?
queries the modulation type.
Response: QQDG

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

Manual operation: See "Modulation Type HSR QPSK" on page 37

[:SOURce<hw>]:BB:GSM:N16Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM16EDge

*RST: QAM16EDge

Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:N16Q:FORM?
queries the modulation type.
Response: QAM16ED

Usage: Query only

Options: (for instruments equipped with option K41 only)

Manual operation: See "Modulation Type 16QAM" on page 36

[:SOURce<hw>]:BB:GSM:N32Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM32EDge

*RST: QAM32EDge
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Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:N32Q:FORM?
queries the modulation type.
Response: QAM32ED

Usage: Query only

Options: (for instruments equipped with option K41 only)

Manual operation: See "Modulation Type 32QAM" on page 37

[:SOURce<hw>]:BB:GSM:AQPSk:ANGLe<ch0> <Angle>

Sets the angle alpha.

Parameters:
<Angle> float

Range: 0.0001  to  89.9999
Increment: 0.0001
*RST: 45

Example: BB:GSM:AQPS:ANGL5 50
Options: R&S SMW-K41

Manual operation: See "Angle alpha_0 ... alpha_7" on page 34

[:SOURce<hw>]:BB:GSM:AQPSk:SCPIR<ch0> <Scpir>

Sets the Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle α as
follows:

SCPIR = 20 * log10(tan α) dB,

where the value of α shall be chosen such that |SCPIR|≤10dB.

Parameters:
<Scpir> float

Range: -115.1625  to  115.1625
Increment: 0.0001
*RST: 0

Example: BB:GSM:AQPS:SCPIR5 -10
BB:GSM:AQPS:ANGL5?
Response: 17.5484

Options: R&S SMW-K41

Manual operation: See "SCPIR_0 .. SCPIR_7" on page 34
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4.3.2 Filter Settings

[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​TYPE?​............................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​PARameter ​.....................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​AQPSK:​TYPE?​................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​EDGE:​TYPE?​..................................................................79
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​N16Qam: ​TYPE?​..............................................................79
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​N32Qam: ​TYPE?​..............................................................79
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​H16Qam: ​TYPE​................................................................80
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​H32Qam: ​TYPE​................................................................80
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​HQPSk:​TYPE​..................................................................80

[:SOURce<hw>]:BB:GSM:FILTer:TYPE?

The command sets the filter type GAUSs. This is the only possible selection in the case
of digital standard GSM.

Return values: 
<Type> GAUSs

*RST: GAUSs

Example: BB:GSM:FILT:TYPE GAUS
sets the filter type GAUSS.

Usage: Query only

Manual operation: See "Filter" on page 33

[:SOURce<hw>]:BB:GSM:FILTer:PARameter <Parameter>

The command sets the filter parameter. For Gaussian filter the BxT is the product of the
bandwidth and the symbol duration. The default value for GSM modulation is 0.3 and for
Gauss Linearized (EDGE), BT = 0.3.

Parameters:
<Parameter> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.3

Example: BB:GSM:FILT:PAR 0.4
sets the BT value to 0.4.

Manual operation: See "Filter Parameter" on page 33

[:SOURce<hw>]:BB:GSM:FILTer:AQPSK:TYPE?

Queries the filter type for AQPSK modulation. The filter is permanently set to GAUSS
linearized.
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Return values: 
<Type> LGAuss

*RST: LGAuss

Usage: Query only

Options: R&S SMW-K41

Manual operation: See "Filter" on page 35

[:SOURce<hw>]:BB:GSM:FILTer:EDGE:TYPE?

The command sets the filter type LGAuss. This is the only possible selection in the case
of digital standard GSM EDGE.

Return values: 
<Type> LGAuss

*RST: LGAuss

Example: BB:GSM:FILT:EDGE:TYPE LGA
sets the filter type Gauss linearized.

Usage: Query only

Manual operation: See "Filter" on page 35

[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE?

Queries filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

Return values: 
<Type> LGAuss

Example: BB:GSM:FILT:N16Q:TYPE?
queries the filter type.
Response: LGA

Usage: Query only

Options: K41

Manual operation: See "Filter" on page 36

[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE?

Queries filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

Return values: 
<Type> LGAuss

Example: BB:GSM:FILT:N32Q:TYPE?
queries the filter type.
Response: LGA

Usage: Query only
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Options: K41

Manual operation: See "Filter" on page 37

[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE <Type>

Sets the filter for HSR 16QAM signal.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:FILT:H16Q:TYPE ENPS

[:SOURce<hw>]:BB:GSM:FILTer:H32Qam:TYPE <Type>

Sets the filter for HSR 32QAM signal.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:FILT:H32Q:TYPE ENPS
Manual operation: See "Filter" on page 38

[:SOURce<hw>]:BB:GSM:FILTer:HQPSk:TYPE <Type>

Sets the filter for HSR QPSK signal.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:FILT:HQPS:TYPE ENPS
Manual operation: See "Filter" on page 37

4.4 Clock Settings

This section lists the remote control commands, necessary to configure the clock.

[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​MODE​...........................................................................80
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​MULTiplier ​.....................................................................81
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​DIVider ​..........................................................................81
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​SOURce ​........................................................................82

[:SOURce<hw>]:BB:GSM:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.
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Parameters:
<Mode> SYMBol | MSYMbol | FSYMbol

Manual operation: See "Clock Mode" on page 24

[:SOURce<hw>]:BB:GSM:CLOCk:MULTiplier <Multiplier>

The command specifies the multiplier for clock type "Multiple Symbols"
(:BB:GSM:CLOCk:MODE MSYM) in the case of an external clock source.

For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Multiplier> integer

Range: 1  to  64
Increment: 1
*RST: 4

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source.
BB:GSM:CLOC:MODE MSYM
selects clock type "Multiple Symbols", i.e. the supplied clock has
a rate which is a multiple of the symbol rate.
BB:GSM:CLOC:MULT 12
the multiplier for the external clock rate is 12.

Manual operation: See "Symbol Clock Multiplier" on page 24

[:SOURce<hw>]:BB:GSM:CLOCk:DIVider <Divider>

The command specifies the divider for clock type "Fractional Symbols"
(:BB:GSM:CLOCk:MODE FSYM) in the case of an external clock source.

For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Divider> integer

Range: 1  to  65536
Increment: 1
*RST: 4

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source.
BB:GSM:CLOC:MODE FSYM
selects clock type "Fractional Symbols", i.e. the supplied clock has
a rate which is a fraction of the symbol rate.
BB:GSM:CLOC:DIV 2
the divider for the external clock rate is 2.

Manual operation: See "Symbol Clock Divider" on page 24
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[:SOURce<hw>]:BB:GSM:CLOCk:SOURce <Source>

The command selects the clock source.

Parameters:
<Source> INTernal | EGC1 | EGC2 | ELCLock | EXTernal

INTernal
The instrument uses its internal clock reference
EGC1|EGC2
External global clock
ELCLock
External local clock
*RST: INTernal

Example: BB:GSM:CLOC:SOUR INT
selects an internal clock reference.
BB:GSM:CLOC:MODE SYMB
specifies that a symbol clock is supplied via the respective clock
connector.

Manual operation: See "Clock Source" on page 23

4.5 Trigger Settings

This section lists the remote control commands, necessary to configure the trigger.

[:​SOURce<hw>]: ​BB:​GSM[:​TRIGger]:​SEQuence ​..................................................................82
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​ARM:​EXECute ​..............................................................83
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXECute ​......................................................................84
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXTernal: ​SYNChronize: ​OUTPut​.....................................84
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OBASeband: ​DELay ​......................................................85
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OBASeband: ​INHibit ​.......................................................85
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​RMODe? ​......................................................................85
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​SLENgth ​......................................................................86
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​SLUNit ​.........................................................................86
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​SOURce ​......................................................................87
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger[:​EXTernal]: ​DELay ​.........................................................88
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger[:​EXTernal]: ​INHibit ​.........................................................88
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXTernal: ​CLOCk: ​DELay ​...............................................88
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXTernal: ​CLOCk: ​INHibit ​...............................................89

[:SOURce<hw>]:BB:GSM[:TRIGger]:SEQuence <Sequence>

The command selects the trigger mode.
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Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

AUTO
The frames are generated continuously.
RETRigger
The frames are generated continuously. A trigger event (internal
or external) causes a restart.
AAUTo
The frames are generated only when a trigger event occurs. After
the trigger event the signal is generated continuously. Signal gen-
eration is stopped with command
SOUR:BB:GSM:TRIG:ARM:EXEC and started again when a trig-
ger event occurs.
ARETrigger
The frames are generated only when a trigger event occurs. The
device automatically toggles to RETRIG mode. Every subsequent
trigger event causes a restart. Signal generation is stopped with
command SOUR:BB:GSM:TRIG:ARM:EXEC and started again
when a trigger event occurs.
SINGle
The signal is generated only when a trigger event occurs. After the
trigger event the signal is generated once to the set sequence
length (SOUR:BB:GSM:TRIG:SLEN). Every subsequent trigger
event causes a restart.
*RST: AUTO

Example: BB:GSM:SEQ AAUT
sets the "Armed_auto" trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the frames continu-
ously.

Manual operation: See "Trigger Mode" on page 16

[:SOURce<hw>]:BB:GSM:TRIGger:ARM:EXECute

The command stops signal generation for trigger modes Armed_Auto and Armed_Ret-
rigger. A subsequent internal or external trigger event restarts signal generation.

Example: BB:GSM:TRIG:SOUR INT
sets internal triggering.
BB:GSM:TRIG:SEQ ARET
sets Armed_Retrigger mode, i.e. every trigger event causes signal
generation to restart.
BB:GSM:TRIG:EXEC
executes a trigger, signal generation is started.
BB:GSM:TRIG:ARM:EXEC
signal generation is stopped.
BB:GSM:TRIG:EXEC
executes a trigger, signal generation is started again.
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Usage: Event

Manual operation: See "Arm" on page 17

[:SOURce<hw>]:BB:GSM:TRIGger:EXECute

The command executes a trigger. The internal trigger source must be selected using the
command :BB:GSM:TRIGger:SOURce INTernal and a trigger mode other than
AUTO must be selected using the command :BB:GSM:SEQ.

Example: BB:GSM:TRIG:SOUR INT
sets internal triggering.
BB:GSM:SEQ RETR
sets Retrigger mode, i.e. every trigger event causes signal gen-
eration to restart.
BB:GSM:TRIG:EXEC
executes a trigger.

Usage: Event

Manual operation: See "Execute Trigger" on page 17

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

ON
The signal calculation starts simultaneously with the external trig-
ger event but because of the instrument's processing time the first
samples are cut off and no signal is outputted. After elapsing of
the internal processing time, the output signal is synchronous to
the trigger event.
OFF
The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequen-
ces with signal duration comparable with the processing time of
the instrument.
*RST: ON

Example: BB:GSM:TRIG:SOUR EXT
sets external triggering.
BB:GSM:TRIG:EXT:SYNC:OUTP ON
enables synchrounous output to external trigger

Manual operation: See "Sync. Output to External Trigger" on page 18
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[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for trig-
gering by the signal from the second path.

Parameters:
<Delay> float

Range: 0 Symbols  to  2^32-1 Symbols
Increment: 1 symbol for CLOCk:SOURce EXT 0.01; symbols for

CLOCk:SOURce INT
*RST: 0 Symbols

Example: BB:GSM:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the signal from the
second path (path B).
BB:GSM:TRIG:OBAS:DEL 200
sets a delay of 200 symbols for the trigger.

Manual operation: See "External Trigger Delay" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only for triggering by the second path.

Parameters:
<Inhibit> integer

Range: 0 Symbols  to  2^32-1 (67 108 863) Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the signal from the
second path (path B).
BB:GSM:TRIG:OBAS:INH 200
sets a restart inhibit for 200 symbols following a trigger event.

Manual operation: See "External Trigger Inhibit" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger:RMODe?

The command queries the status of frame generation for all trigger modes with GSM/
EDGE modulation on.
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Return values: 
<RMode> STOP | RUN

RUN
the GSM/EDGE signal is generated. A trigger event occurred in
the triggered mode.
STOP
the GSM/EDGE signal is not generated. A trigger event did not
occur in the triggered modes, or signal generation was stopped by
the command :BB:GSM:TRIG:ARM:EXECute (armed trigger
modes only).

Example: BB:GSM:TRIG:SOUR EXT
sets external triggering.
BB:GSM:TRIG:MODE ARET
selects the Armed_Retrigger mode.
BB:GSM:TRIG:RMOD?
queries the status of frame generation.
Response: RUN
the frame is generated, an external trigger was executed.

Usage: Query only

Manual operation: See "Running/Stopped" on page 17

[:SOURce<hw>]:BB:GSM:TRIGger:SLENgth <SLength>

The command defines the length of the signal sequence to be output in the "Single" trigger
mode. The unit is defined with command SOUR:BB:GSM:TRIG:SLUNit. It is possible
to output deliberately just part of a frame, an exact sequence of a frame, or a defined
number of repetitions of a frame.

Parameters:
<SLength> integer

Range: 1 Symbol  to  2^32-1 Symbols
*RST: 1 Symbol

Example: BB:GSM:SEQ SING
sets trigger mode Single.
BB:GSM:TRIG:SLUN SYMB
sets unit symbol for the entry of signal duration.
BB:GSM:TRIG:SLEN 200
sets signal duration of 200 symbols. 200 symbols will be output
after the next trigger event.

Manual operation: See "Trigger Signal Duration" on page 17

[:SOURce<hw>]:BB:GSM:TRIGger:SLUNit <SLunit>

The command defines the unit for the entry of the length of the signal sequence
(SOUR:BB:GSM:TRIG:SLEN) to be output in the "Single" trigger mode
(SOUR:BB:GSM:SEQ SING).
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Parameters:
<SLunit> FRAMe | SYMBol

*RST: FRAMe

Example: BB:GSM:SEQ SING
sets trigger mode Single.
BB:GSM:TRIG:SLUN FRAM
sets unit frame for the entry of signal duration.
BB:GSM:TRIG:SLEN 2
sets signal duration of 2 frames. The current frame will be output
twice after the next trigger event.

Manual operation: See "Signal Duration Unit" on page 17

[:SOURce<hw>]:BB:GSM:TRIGger:SOURce <Source>

The command selects the trigger source.

Parameters:
<Source> INTB | INTernal | OBASeband | EGT1 | EGT2 | EGC1 | EGC2 |

ELTRigger | INTA | ELCLock | BEXTernal | EXTernal
INTernal
Internal
INTA | INTB
Internal trigger from the other baseband
EGT1 | EGT2
External global trigger
EGC1 | EGC2
External global clock
ELTRigger
External local trigger
ELCLock
External local clock
OBASeband|BEXTernal|EXTernal
Provided only for backward compatibility with other R&S signal
generators.
The R&S SMW accepts these values und maps them automati-
cally as follow:
EXTernal = EGT1, BEXTernal = EGT2, OBASeband = INTA or
INTB (depending on the current baseband)
*RST: INTernal

Example: BB:GSM:TRIG:SOUR INT
sets internal triggering.

Manual operation: See "Trigger Source" on page 18
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[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal]:DELay <Delay>

Specifies the trigger delay (expressed as a number of samples) for external triggering.
The value affects all external trigger signals.

Parameters:
<Delay> float

*RST: 0

Example: BB:GSM:TRIG:SOUR EXT
selects an external trigger.
BB:GSM:TRIG:EXT:DEL 50
sets a delay of 50 symbols for the trigger.

Manual operation: See "External Trigger Delay" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following an external
trigger event.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: BB:GSM:TRIG:SOUR EXT
selects an external trigger.
BB:GSM:TRIG:EXT:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "External Trigger Inhibit" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:CLOCk:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for external
triggering via the clock input.

This command applies only if external clock source (BB:GSM:CLOC:SOUR EXT) and
trigger source external clock (BB:GSM:TRIG:SOUR CLOC) are selected.

For two-path instruments, this command applies only for baseband path A.

Parameters:
<Delay> float

Range: 0 Symbols  to  2^16-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols
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Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source.
BB:GSM:TRIG:SOUR ECL
selects an external trigger by means of the external clock.
BB:GSM:TRIG:EXT:CLOC:DEL 200
sets a delay of 200 symbols for the trigger.

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:CLOCk:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only if external clock source
(BB:GSM:CLOC:SOUR EXT) and trigger source external clock (BB:GSM:TRIG:SOUR
CLOC) is selected.

For two-path instruments, this command applies only for baseband path A.

Parameters:
<Inhibit> integer

Range: 0 Symbols  to  2^26-1 (67 108 863) Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source.
BB:GSM:TRIG:SOUR ECL
selects an external trigger by means of the external clock.
BB:GSM:TRIG:EXT:CLOC:INH 200
sets a restart inhibit for 200 symbols following a trigger event.

4.6 Marker Settings

This section lists the remote control commands, necessary to configure the markers.

[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut:​DELay: ​FIXed​...................................................90
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​DELay ​......................................................90
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​DELay: ​MAXimum? ​....................................90
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[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut:DELay:FIXed <Fixed>

The command restricts the marker delay setting range to the dynamic range. In this range
the delay can be set without restarting the marker and signal. If a delay is entered in
setting ON but is outside this range, the maximum possible delay is set and an error
message is generated.

The numeric suffix in OUTPut has no significance for this command, since the setting
always affects every marker.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

Manual operation: See "Marker x Delay" on page 22

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay <Delay>

The command defines the delay between the signal on the marker outputs and the start
of the frame/slot, expressed in terms of symbols.

Command :BB:GSM:TRIGger:OUTPut:DELay:FIXed can be used to restrict the
range of values to the dynamic range, i.e. the range within which a delay of the marker
signals can be set without restarting the marker and signal.

Parameters:
<Delay> float

Range: 0 Symbols  to  2^24-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:TRIG:OUTP:DEL 16
sets a delay of 16 symbolsfor the corresponding marker signal.

Manual operation: See "Marker x Delay" on page 22

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MAXimum?

The command queries the maximum marker delay for set-
ting :BB:GSM:TRIGger:OUTPut:DELay:FIXed ON.

Return values: 
<Maximum> float
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Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:GSM:TRIG:OUTP:DEL:MAX
queries the maximum of the dynamic range.
Response: '2000'
the maximum for the marker delay setting is 2000 symbols.

Usage: Query only

Manual operation: See "Marker x Delay" on page 22

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MINimum?

The command queries the minimum marker delay for set-
ting :BB:GSM:TRIGger:OUTPut:DELay:FIXed ON.

Return values: 
<Minimum> float

Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:GSM:TRIG:OUTP:DEL:MIN
queries the minimum of the dynamic range.
Response: '0'
the minimum for the marker delay setting is 0 symbols.

Usage: Query only

Manual operation: See "Marker x Delay" on page 22

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:MODE <Mode>

The command defines the signal for the selected marker output.
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Parameters:
<Mode> SDEF | FRAMe | SLOT | PULSe | PATTern | RATio

As defined in slots
The marker defined in the burst editor is used.
SLOT
A slot clock with the slot period specified using command
SOUR:BB:GSM:TRIG:OUTP:PER:SLOT is generated on the out-
put connector. The marker signal is generated after every speci-
fied number of slots. It is important to be aware of the variation in
the GSM/EDGE slot length between 156 and 157 symbols. At a
slot length of 156 symbols, a period of 1 symbol and a symbol rate
of 270.833 ksymb/s the clock is 0.577 ms, and at 157 symbols it
is 0.580 ms.
FRAMe
A frame clock with the frame period specified using command
SOUR:BB:GSM:TRIG:OUTP:PER:FRAM is generated on the out-
put connector. The marker signal is generated after every speci-
fied number of frames. A GSM/EDGE frame has 1250 symbols.
At a symbol rate of 270.833 ksymb/s and a period of 1 the clock
is 4.615 ms.
PULSe
A pulsed marker signal is generated. The pulse frequency
PATTern
A marker signal is generated with the aid of a user-definable bit
pattern. The bit pattern is entered with the aid of command
SOURce:BB:GSM:TRIGg:OUTP:PATT. The bit pattern is a max-
imum of 32 bits long.
RATio
A regular marker signal corresponding to the Time Off / Time On
specifications in the commands
SOUR:BB:GSM:TRIGge:OUTP:OFFT and
SOUR:BB:GSM:TRIGg:OUTP:ONT is generated.

*RST: FRAMe

Example: BB:GSM:TRIG:OUTP2:MODE PULS
selects the pulsed marker for the corresponding marker signal.

Manual operation: See "Marker Mode" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:OFFTime <OffTime>

The command sets the number of symbols in a period (ON time + OFF time) during which
the marker signal in setting SOURce:BB:GSM:TRIGger:OUTPut:MODE RATio on the
marker outputs is OFF.
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Parameters:
<OffTime> integer

Range: 1 Symbol  to  2^24-1 Symbols
Increment: 1 Symbol
*RST: 1 Symbol

Example: BB:GSM:TRIG:OUTP2:OFFT 20
sets an OFF time of 20 symbols for marker signal 2.

Manual operation: See "Marker Mode" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PATTern <Pattern>

The command defines the bit pattern used to generate the marker signal in the setting
SOURce:BB:GSM:TRIGger:OUTPut:MODE PATTern 0 is marker off, 1 is marker on.
The pattern has a maximum length of 64 bits.

Parameters:
<Pattern> integer

*RST: 0

Example: BB:GSM:TRIG:OUTP2:PATT #H81,8
sets a bit pattern.
BB:GSM:TRIG:OUTP2:MODE PATT
activates the marker signal according to a bit pattern for the cor-
responding marker signal.

Manual operation: See "Marker Mode" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod:SLOT <Slot>

The command sets the repetition rate for the slot clock at the marker outputs.

Parameters:
<Slot> integer

Range: 1 Slot  to  2^26-1 Slots
Increment: 1 Slot
*RST: 1 Slot

Example: BB:GSM:TRIG:OUTP2:MODE SLOT
sets the slot clock for the corresponding marker signal.
BB:GSM:TRIG:OUTP2:PER:SLOT 16
sets a period of 16 slots, i.e. the marker signal is repeated every
16th slot.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod[:FRAMe] <Frame>

The command sets the repetition rate for the frame clock at the marker outputs.
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Parameters:
<Frame> integer

Range: 1 Frame  to  2^26-1 Frames
Increment: 1 Frame
*RST: 1 Frame

Example: BB:GSM:TRIG:OUTP2:MODE FRAM
sets the frame clock for the corresponding marker signal.
BB:GSM:TRIG:OUTP2:PER 16
sets a period of 16 frames, i.e. the marker signal is repeated every
16th frame.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

The command sets the divider for the pulsed marker signal in the setting
SOURce:BB:GSM:TRIGger:OUTPut:MODE PULSe. The pulse frequency is derived by
dividing the symbol rate by the divider.

Parameters:
<Divider> integer

Range: 2  to  2^10
Increment: 1
*RST: 2

Example: BB:GSM:TRIG:OUTP2:PULS:DIV 2
sets the divider for the corresponding marker signal to the value
2.
BB:GSM:TRIG:OUTP2:FREQ?
queries the resulting pulse frequency of the marker signal.
Response: 66 000
the resulting pulse frequency is 66 kHz.

Manual operation: See "Marker Mode" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQuency]?

The command queries the pulse frequency of the pulsed marker signal in the setting
SOUR:BB:GSM:TRIG:OUTP:MODE PULS. The pulse frequency is derived by dividing
the symbol rate by the divider. The divider is defined with command
SOUR:BB:GSM:TRIG:OUTP:PULS:DIV.

Return values: 
<Frequency> float
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Example: BB:GSM:TRIG:OUTP:PULS:DIV 4
sets the divider for the corresponding marker signal to the value
4.
BB:GSM:TRIG:OUTP:MODE PULS
enables the pulsed marker signal.
BB:GSM:TRIG:OUTP:PULS:FREQ?
queries the resulting pulse frequency for the marker signal.
Response: 33 000
the resulting pulse frequency is 33 kHz.

Usage: Query only

Manual operation: See "Marker Mode" on page 20

4.7 Power Ramping/Slot Attenuation

[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​BBONly[:​STATe]​............................................................95
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​FDELay ​.........................................................................95
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​RDELay ​........................................................................96
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​SHAPe ​..........................................................................96
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​TIME​.............................................................................97

[:SOURce<hw>]:BB:GSM:PRAMp:BBONly[:STATe] <State>

Note: This command is available for instruments with RF output only.

This command selects power ramping in the baseband only or mixed power ramping in
the baseband and the RF section. The "ON" setting is mandatory if, with power ramping
active, only the baseband signal is output (I/Q outputs), or, in case of two-path instru-
ments, if a baseband signal is applied to two RF paths (RF A and RF B).

Only then can a signal with a defined, predictable level be output.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:PRAM:BBON ON
selects power ramping in the baseband only.

Manual operation: See "Baseband Only - Power Ramp Control" on page 42

[:SOURce<hw>]:BB:GSM:PRAMp:FDELay <FDelay>

The command sets the offset in the Falling edge of the ramp envelope at the end of a
slot. A positive value gives rise to a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

 

Power Ramping/Slot Attenuation



Remote-Control CommandsGSM/EDGE, EDGE Evolution

96User Manual 1175.6684.02 ─ 02

Parameters:
<FDelay> float

Range: -9 Symbols  to  9 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:PRAM:FDEL -1
sets an advance of 1 symbol in the falling edge of the envelope at
the end of the slot.

Manual operation: See "Fall Delay - Power Ramp Control" on page 42

[:SOURce<hw>]:BB:GSM:PRAMp:RDELay <RDelay>

The command sets the offset in the Rising edge of the ramp envelope at the start of a
slot. A positive value gives rise to a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

Parameters:
<RDelay> float

Range: -9 Symbols  to  9 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:PRAM:RDEL -1
sets an advance of 1 symbol in the rising edge of the envelope at
the start of the slot.

Manual operation: See "Rise Delay - Power Ramp Control" on page 42

[:SOURce<hw>]:BB:GSM:PRAMp:SHAPe <Shape>

The command sets the edge shape of the ramp envelope.

Parameters:
<Shape> LINear | COSine

LINear
The transmitted power rises and falls linear fashion.
COSine
The transmitted power rises and falls in the shape of a cosine.
*RST: COSine

Example: BB:GSM:PRAM:SHAP LIN
sets a cosine-shaped rise and fall to the edge.

Manual operation: See "Ramp Function" on page 41
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[:SOURce<hw>]:BB:GSM:PRAMp:TIME <Time>

The command sets the edge slope of the ramp envelope. This specifies the number of
symbols over which the switching operation should be stretched when the transmitted
power is turned on and off.

Parameters:
<Time> float

Range: 0.3 Symbols  to  16.0 Symbols
Increment: 0.1 Symbols
*RST: 5.0 Symbols

Example: BB:GSM:PRAM:TIME 6
sets the duration of the switching operation to 6 symbols.

Manual operation: See "Ramp Time" on page 41

4.8 Burst Editor
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SFLag: ​USE ​.........................................................................................................104
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[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
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[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
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SYNC: ​SELect ​......................................................................................................106

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
SYNC: ​USER ​.......................................................................................................107

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
FCORrection: ​FIXed​..............................................................................................107

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
FCORrection: ​FIXed:​PATTern​................................................................................107

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
DUMMy: ​MIXed:​PATTern? ​....................................................................................108

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>:TYPE <Type>

The command selects the burst (slot) type.

Parameters:
<Type> NORMal | HALF | EDGE | SYNC | FCORrection | DUMMy |

ACCess | ADATa | AEDGe | N16Qam | N32Qam | A16Qam |
A32Qam | HQPSk | H16Qam | H32Qam | HAQPsk | HA16Qam |
HA32Qam | NAFF | NAFH | NAHH | AAQPsk
N16Qam | N32Qam
Normal 16QAM | Normal 32QAM
HQPSk | H16Qam | H32Qam
HSR QPSK | HSR 16QAM | HSR 32QAM
NAFF | NAFH | NAHH
Normal AQPSK Full rate - Full rate | Normal AQPSK Full rate - Half
rate | Normal AQPSK Half rate - Half rate
Axxxxx (All Data)
The types All Data GSM (ADATa), All Data EDGE (AEDGe), All
Data AQPSK (AAQPSk), All Data 16QAM (A16Qam), All Data
32QAM (A32Qam), HSR All Data QPSK (HAQPsk), HSR All Data
16QAM (HA16Qam) and HSR All Data 32QAM (HA32Qam) are not
defined in the standard.
*RST: NORMal

Example: BB:GSM:SLOT:TYPE DUMM
selects DUMMY burst type for slot 1.

Options: Higher Symbol Rate Mode, higher order modulation schemes
(16QAM and 32QAM) and AQPSK modulation are available for
instruments equipped with option R&S SMW-K41 only.

Manual operation: See "Burst Type" on page 44
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:LEVel <Level>

The command defines the power control level of the selected slot.

Parameters:
<Level> OFF | ATT | FULL

OFF
The slot is inactive.
ATT
The power is reduced by the amount defined
using :BB:GSM:SLOT:ATT.

FULL
Full power as specified by the level setting.
*RST: Slot 0: FULL; Slots 1...7: OFF

Example: BB:GSM:SLOT2:LEV FULL
selects power control level Full Power for slot 2.

Manual operation: See "Slot Level" on page 49

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ATTenuation <Attenuation>

The command selects one of seven possible values for the level attenuation. This value
defines by how much the power of the selected slot with power control
level :BB:GSM:SLOT:LEV ATT will be reduced in relation to the normal output power
(attribute ...:LEVEL FULL). The seven possible values are set using the com-
mand :SOURce:BB:GSM:SATTenuation<n>.

Parameters:
<Attenuation> A1 | A2 | A3 | A4 | A5 | A6 | A7

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT
sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB
sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT A1
sets the level attenuation for slot 0 to 12 dB.

Manual operation: See "Slot Attenuation" on page 49

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SCPIRatio <SCPIRatio>

The command selects one of eight possible values for the SCPIR. The eight possible
values are set using the command ​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​SCPIR<ch0> ​.

Burst Editor



Remote-Control CommandsGSM/EDGE, EDGE Evolution

100User Manual 1175.6684.02 ─ 02

Parameters:
<SCPIRatio> SCPIR7 | SCPIR6 | SCPIR5 | SCPIR4 | SCPIR3 | SCPIR2 |

SCPIR1 | SCPIR0
*RST: SCPIR0

Example: BB:GSM:AQPS:SCPIR5 -10
BB:GSM:SLOT:SUBC2:SCPIR SCPIR5

Manual operation: See "SCPIR" on page 48

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FILTer:TYPE <Type>

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter should be use for
the selected burst type and modulation.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:FRAM1:SLOT1:TYPE H16Q
selects HSR 16QAM burst type for slot 1.
BB:GSM:FRAM1:SLOT1:FILT:TYPE EWPS
selects Wide Pulse Shape filter for slot 1.

Options: R&S SMW-K41

Manual operation: See "Filter" on page 37

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:COUNt <Count>

The command defines the number of slots combined in a multislot. Since multislot
involves connecting multiple slots to a single user channel, this configuration is possible
for Normal (Full Rate) bursts Normal (8PSK / EDGE) burst
(SOUR:BB:GSM:FRAM:SLOT:TYPE NORM|EDGE) and EDGE Evolution bursts.

The suffix in MULTislot defines the first slot in a multislot group. In a multiframe con-
figuration this setting applies to the slots in all frames.

Parameters:
<Count> integer

Range: 1  to  8
*RST: 1
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Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SLOT0:TYPE NORM
selects the NORMal burst type for slot 0.
... SLOT1 ... SLOT7
selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULT0:COUN 8
defines a multislot from all 8 slots.
BB:GSM:MULT0:STAT ON
switches the multislot configuration on.

Manual operation: See "Number of Slots" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>:VOJitter <State>

Enables/disables the simulation of a timing jitter for GMSK bursts.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: :SOURce1:BB:GSM:FRAMe1:SLOT2:VOJitter ON
Manual operation: See "VAMOS Offset Jitter" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA <Data>

The command defines the data source for the DATA fields in the burst. This command
is valid only when burst types that contain data fields are selected. If a burst contains
multiple DATA fields, these are treated as a continuous field, and for instance data such
as a pseudo-random sequence is continued without interruption from one DATA field to
the next.

In "GSM Mode Unframed", this command defines the data source for the unframed signal.
The suffix in :SLOT has to be set to 0 (BB:GSM:SLOT0:DATA).
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Parameters:
<Data> ALL0 | ALL1 | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 | PN21 |

PN23 | DLISt
PNxx
The pseudo-random sequence generator is used as the data
source. There is a choice of different lengths of random sequence.
DLISt
A data list is used. The data list is selected with the aid of command
SOURce:BB:GSM:SLOT:DATA:DLISt.

ALL0 | ALL1
Internal 0 or 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined with
the aid of command :SOURce:BB:GSM:SLOT:DATA:PATTern.

*RST: PN9

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:DATA PN15
selects internal PRBS data with period length 215-1 as the data
source for the DATA fields in the burst. The pseudo-random
sequence is continued without interruption from one DATA field to
the next.

Manual operation: See "Data" on page 25

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:DLISt <DList>

The command selects a data list. This command is only valid for bursts with DATA fields.
This data list is only used if it is set as the data source with the aid of com-
mand :BB:GSM:SLOT:DATA DLIS.

Parameters:
<DList> string

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:DATA DLIS
selects internal data lists as the data source for DATA fields.
BB:GSM:SLOT2:DATA:DLIS 'test'
selects the test data list. The data list is continued without inter-
ruption from one DATA field to the next.

Manual operation: See "Data" on page 25
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:DLISt:CATalog?

This command reads out the data list files in the default directory. The default directory
is set using command MMEM:CDIRectory. Only files with the file extension *.dm_iqd
will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/temp/dlist_gsm'
sets the default directory to /var/user/temp/dlist_gsm.
BB:GSM:SLOT2:DATA:DLIS:CAT?
queries the available data lists in /var/user/temp/dlist_gsm.
Response: 'test_01','test_02'
data lists test_01 and test_02 are available in /var/user/temp/
dlist_gsm.

Usage: Query only

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:PATTern <Pattern>

The command selects the data pattern for the internal data when PATTern is selected
as the data source. The length depends on the length of the data fields in the selected
burst type.

Parameters:
<Pattern> integer

Example: BB:GSM:SLOT2:TYPE ACC
selects the Access burst type for slot 2. This burst type contains a
36-bit data field.
BB:GSM:SLOT2:DATA PATT
selects Pattern as the data source.
BB:GSM:SLOT2:DATA:PATT #H801FA,20
generates the data for the data field in the burst.

Manual operation: See "Data" on page 25

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:STATe <State>

The command switches the multislot configuration on.

The suffix in MULTislot defines the first slot in a multislot group. In a multiframe config-
uration this setting applies to the slots in all frames.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF
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Example: BB:GSM:MODE DOUB
selects GSM mode Frame (Double).
BB:GSM:SLOT0:TYPE NORM
selects the NORMal burst type for slot 0.
... SLOT1 ... SLOT7
selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULT0:COUN 8
defines a multislot from all 8 slots.
BB:GSM:MULT0:STAT ON
switches the multislot configuration on.

Manual operation: See "Multislot Configuration" on page 49

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SFLag <SFlag>

The command sets the Stealing Flag state (only for Normal burst :BB:GSM:SLOT:TYPE
NORM).

Parameters:
<SFlag> 0 | 1

*RST: 0

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1
sets Stealing Flags for slot 2 to the value 1.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SFLag:USE <Use>

The command enables or disables the use of Stealing Flags. If not used, the Stealing
Flags bits are allocated to the DATA fields (only for Normal burst :BB:GSM:SLOT:TYPE
NORM).

Parameters:
<Use> 0 | 1 | OFF | ON

*RST: ON

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1
sets Stealing Flags for slot 2 to the value 1.
BB:GSM:SLOT2:SFL:USE ON
enables the use of Stealing Flags for slot 2.

Manual operation: See "Burst Fields" on page 50
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:SELect <Select>

The command selects the training sequence code. The values specified in GSM 5.02 are
T0...T7. When USER is selected, the value specified with the aid of
the ...:TSC:USER command described next is used.

Parameters:
<Select> T0 | T1 | T2 | T3 | T4 | T5 | T6 | T7 | USER

*RST: T0

Example: BB:GSM:MODE SING
selects Single Frame mode.
BB:GSM:SLOT2:TYPE NORM
selects Normal burst for slot 2.
BB:GSM:SLOT2:TSC:SEL T3
selects training sequence code T3 for slot 2.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:SET <Set>

Sets the TSC set for the corresponding GMSK normal burst or VAMOS subchannel, user
and slot.

Parameters:
<Set> SET1 | SET2

*RST: SET1

Example: BB:GSM:SLOT2:SUBC2:USER2:TSC:SET SET2
Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:USER <User>

The command specifies the user-defined training sequence code. This code is used if
the USER parameter is set with the aid of the ​[: ​SOURce<hw>]: ​BB: ​GSM[: ​
FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​USER<ch>][: ​SOURce]: ​TSC: ​
SELect ​ command. The length is 26 bits for :BB:GSM:SLOT:TYPE NORMal and 78 bits
for :BB:GSM:SLOT:TYPE EDGE.

Parameters:
<User> integer

Range: #B0,1  to  #B111 ,1...26/78 bits
*RST: #H0970897

Example: BB:GSM:SLOT3:TSC:USER #H3FFFFFF
enters the user-defined training sequence for slot 3.

Manual operation: See "Burst Fields" on page 50
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ETSC <Etsc>

The command selects an extended training sequence for the Synchronization burst.
There is a choice of three predefined sequences STANdard | CTS | COMPact and,
if defined, a USER sequence (only for selection of burst type :BB:GSM:SLOT:TYPE
SYNC).

Parameters:
<Etsc> STANdard | CTS | COMPact | USER

Example: BB:GSM:SLOT:TYPE SYNC
selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC CTS
selects the extended training sequence CTS.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ETSC:USER <User>

(only for selection of burst type :BB:GSM:SLOT:TYPE SYNC)

The command selects an extended training sequence for the Synchronization burst
USER sequence.

Parameters:
<User> integer

Example: BB:GSM:SLOT:TYPE SYNC
selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC USER
selects the extended training sequence User.
BB:GSM:SLOT:ETSC:USER #H5a5a5a5a5a5a5a5a,64
sets the ETSC.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SYNC:SELect <Select>

The command selects a training sequence (SYNC sequence) for the Access burst (only
for burst type selection :BB:GSM:SLOT:TYPE ACC).

Parameters:
<Select> T0 | T1 | T2 | USER

*RST: T0

Example: BB:GSM:SLOT1:TYPE ACC
selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL T1
selects Sync sequence T1.
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Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SYNC:USER <User>

The command outputs the bit pattern of the User Sync sequence for the Access burst.
The length is 64 bits. Superfluous bits are truncated on input. Missing bits are filled with
0. The command is valid only for selection :BB:GSM:SLOT:SYNC:SEL USER and for
burst type selection :BB:GSM:SLOT:TYPE ACC.

Parameters:
<User> integer

Range: #B0,1  to  #B111...,41
*RST: Bit pattern from T0

Example: BB:GSM:SLOT1:TYPE ACC
selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL USER
selects the User Sync sequence.
BB:GSM:SLOT1:SYNC:USER #HFFFFFFFFFF0,41
enters the User Sync sequence.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FCORrection:FIXed <Fixed>

The command selects the content of the FIXED field for the Frequency Correction burst.
There is a choice of two predefined sequences STANdard and COMPact and, if defined,
a USER sequence (only for burst type selection :BB:GSM:SLOT:TYPE FCORrection).

Parameters:
<Fixed> STANdard | COMPact | USER

*RST: STANdard

Example: BB:GSM:SLOT:TYPE FCOR
selects Frequency Correction burst for slot 1.
BB:GSM:SLOT:FCOR:FIX COMP
selects content type COMPact for the Fixed field.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FCORrection:FIXed:PATTern <Pattern>

The command enters the bit pattern of the FIXED field for the Frequency Correction burst.
The length is 142 bits. Superfluous bits are truncated on input. Missing bits are filled with
0. The command is valid only for the selection :BB:GSM:SLOT:FCOR:FIX USER and
for burst type selection :BB:GSM:SLOT:TYPE FCOR.
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Parameters:
<Pattern> integer

Range: #B000...0,142  to  #B111...1,142
*RST: Bit pattern from the STANdard

Example: BB:GSM:SLOT:TYPE FCOR
selects Synchronization burst for slot 1.
BB:GSM:SLOT:FCOR:FIX USER
selects content type USER for the Fixed field.
BB:GSM:SLOT:FCOR:FIX:PATT #B0,142
enters the content of the field.

Manual operation: See "Burst Fields" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:DUMMy:MIXed:PATTern?

This command outputs the bit pattern of the Mixed field of the Dummy burst. The contents
of the Mixed field is fixed and specified by the standard, the length is 142 bits.

Return values: 
<Pattern> integer

Example: BB:GSM:SLOT1:TYPE DUMM
selects Dummy burst for slot 1.
BB:GSM:SLOT1:DUMM:MIX:PATT?
outputs the bit pattern of the Mixed field.
Response:

Usage: Query only

Manual operation: See "Burst Fields" on page 50

4.9 Slot Marker Definition

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:TRIGger:
OUTPut:TAG?

The command queries the content of the specified marker in the selected file.

Suffix: 
<di>

.
<di>

<st0> 0|[1] .. 7

<ch> <di>

Parameters:
<Tag> string
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Example: BB:GSM:FRAM:SLOT0:UER1:TRIG:OUTP:TAG? "MARKER
LIST 1"
queries the content of the marker list 1.
Response: 0:1;59:0;64:1,70:0

Usage: Query only

Manual operation: See "Configure Control Signal" on page 57
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